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CHAPTER 1

Introduction
Micro content is short, concise information that stands alone and is easily consumable. In Flare, it
begins with the creation of a collection of brief phrases and corresponding responses, such as
questions and answers. After generating HTML5 output, these phrase/response combinations can
be used in different ways as users interact with your output. For example, it can greatly improve the
user experience when people search in your HTML5 output. It can also be used to create field-level
context-sensitive Help.
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MICRO CONTENT EDITOR
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OUTPUT
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General Information

n "Uses for Micro Content" on page 12

n "Micro Content Tutorials and Examples" on page 14

n "Micro Content File and Editor" on page 15

n "Micro Content Phrases" on page 16

n "Micro Content Responses" on page 33

n "Micro Content and Meta Tags" on page 42

n "Micro Content Containers and Proxies" on page 43

n "Micro Content and Snippets" on page 57

n "Micro Content Features Per Output Type" on page 59

n "What the MadCap Doc Team Does for Micro Content" on page 61

Process for Containers in Search Results or Topics

1. Create micro content phrases and responses.

2. Set up micro content containers.

3. (Optional) In the skin, edit the look of micro content.

Process for Field-Level Help

1. Create micro content phrases and responses.

2. Open the alias file that you created.

3. On the left side of the Alias Editor, find and expand the micro content file containing phrases
that you want to assign to new IDs.

4. Right-click a micro content phrase, and select Assign to New Identifier.

5. (Optional) If you want to make changes (e.g., modify the ID name or number), click in the
appropriate cell and type the new information.

6. Click to save your work.

7. Following the standard CSH process, providing your developer with the IDs.
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Process for Other Purposes (e.g., Chatbots)

1. Create micro content phrases and responses.

2. Build HTML5 output.

3. In Windows, navigate to the project's MicroContent output subfolder (e.g., [project name] >
Output > [user name] > [target name] > MicroContent).

4. A developer uses a third-party chatbot application and/or does extra programming and work
outside of Flare, pointing to the files in your MicroContent output folder as necessary. This
person does not need to be a Flare user or have a Flare license.
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CHAPTER 2

General Information for Micro
Content
There are various pieces of general information you should know if you plan to use this feature.

This chapter discusses the following:

Uses for Micro Content 12

Micro Content Tutorials and Examples 14

Micro Content File and Editor 15

Micro Content Phrases 16

Micro Content Responses 33

Micro Content and Meta Tags 42

Micro Content Containers and Proxies 43

Micro Content and Snippets 57

Micro Content Features Per Output Type 59

What the MadCap Doc Team Does for Micro Content 61
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Uses for Micro Content
There are multiple potential uses for micro content, but some take more effort than others. Some
uses—featured snippets and Knowledge Panel in search results—are quite easy to produce, and all
steps can be completed in a matter of minutes in Flare. Other uses—FAQ, Knowledge, and
Promotion proxies—are more advanced and require a bit more setup. If you want to create field-
level Help with micro content, you can complete all of the author-related tasks in Flare, but then you
might need to have a developer make context-sensitive Help (CSH) calls in a software application.
As for other possible uses, you can create the phrase/responses in Flare, but then you would also
need to do additional work outside of your project (possibly with the assistance of a third-party
application) in order to produce the final result. Just how much work depends on what you are
trying to accomplish.
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n "Featured Snippets" on page 98

n "Knowledge Panel" on page 102

n "FAQ Proxy" on page 107

n "Knowledge Proxy" on page 113

n "Promotion Proxy" on page 117

n "Micro Content and Context-Sensitive Help" on page 126

n "Using Micro Content for Chatbots and Other Advanced Purposes" on page 122
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Micro Content Tutorials and Examples
In addition to the other information in this section, we recommend you also walk through the micro
content tutorials and read various detailed examples to gain a better understanding of the micro
content features and how they work.

Tutorials
n Micro Content Tutorial—Basic (see the online Help)

Approximate Time: 25 minutes

Welcome to the Flare Micro Content Tutorial—Basic.

l Tutorial Goal Learning how to create micro content for HTML5 search results.

l Key Concepts Creating a micro content file with phrases and responses, and single-
sourcing micro content.

n Micro Content Tutorial—Advanced (see the online Help)

Approximate Time: 1 hour, 45 minutes

Welcome to the Flare Micro Content Tutorial—Advanced.

l Tutorial Goal Learning how to use the various types of micro content containers, as well
as skin settings.

l Key Concepts Populating containers with micro content in search results and topics
through various settings, including meta tags, and modifying skins to control the look.

Examples
n "Examples—"What" and "How" Content" on page 138

n "Examples—Related Information" on page 154

n "Examples—FAQs" on page 169

n "Examples—Random Tips" on page 178
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Micro Content File and Editor
To start creating micro content, you first must add a micro content file to the Content Explorer. It is
recommended that you create a subfolder named "MicroContent" under the Resources folder. Then
right-click that subfolder, select New > Micro Content, and complete the fields to create the new file.
A micro content file opens in the Micro Content Editor, where you add phrases and responses.
Initially, you will see one phrase/response combination, which you can replace with your own
content. See "Creating Micro Content" on page 83.
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Micro Content Phrases
The first part of micro content is the phrase, which is what a reader uses when performing a search
(or interacting with, say, a chatbot). In Flare’s Micro Content Editor, you can use the local toolbar to
create and manage phrases. The phrases are listed in a grid, where you can use additional options
specific to each phrase. When you select a phrase in the Micro Content Editor grid, the associated
response is shown in the area to the right.

Toolbar
Adds a new phrase to the grid below. Replace the generic text with your own phrase.

You can also right-click in the grid and select Add Phrase from the context menu. The
keyboard shortcut option is CTRL+SHIFT+N.

Adds a new alternate phrase under the main phrase that is selected in the grid below.
Replace the generic text with your own alternate phrase. Adding an alternate phrase
ensures that the response will display for the end user, even though the main phrase
is not used.

You can also right-click in the grid and select Add Alternate Phrase from the context
menu.

Opens a dialog, which lets you choose a topic or snippet, linking it to the main phrase
that is selected in the grid below. You can also choose a bookmark within the linked
file. After adding a link, the content in the linked file is shown in the response area to
the right, although it is read-only; to edit the content, you must do so in the topic or
snippet file itself. If you selected a bookmark when linking the file, the response will
include any content after the point of that bookmark in the file. The linked file name is
also shown under the main phrase when you expand it in the grid.

After adding a link, the button changes to , which you can click to remove the link.
In the response area to the right, the content from the linked file is converted to text.

You can also right-click in the grid and select Add Link or Remove Link/Convert to
Text from the context menu.
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Deletes the selected phrase or alternate phrase in the grid. Use caution when deleting
a main phrase, because any associated content entered directly into the response
area (as opposed to a linked file) will also be removed.

You can also right-click in the grid and select Delete Phrase from the context menu.

Opens the Variables dialog, which lets you insert a variable into the phrase. This
button is enabled only if you first select the phrase text (e.g., click it and press F2) so
that it can be edited.

Toggles between showing or hiding any variable definitions found in the grid. By
default, only the variable syntax is initially shown, but after clicking this button, you
will see its definition.

Opens the Properties dialog for the phrase so that you can edit settings for it,
including the ID, meta tags, condition tags, and more.

Toggles between sorting the grid alphabetically or letting you move the phrases where
you want via the up and down arrows.

Moves the selected phrase up (when the grid is in custom sorting mode).

Moves the selected phrase down (when the grid is in custom sorting mode).

Expands all the phrase entries in the grid below, so that you can see any links or
alternate phrases associated with them.

Collapses all the phrase entries in the grid below, so that you can see only the main
phrases, rather than any links or alternate phrases associated with them.
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Shows or hides colored shading (and in some cases a colored square) where
conditions have been applied.

EXAMPLE Your condition has blue associated with it and you have applied
this tag to a micro content phrase. When you click this button to show the
indicator, the square next to the phrase displays in blue. If more than one
condition is applied to the phrase, the square displays all of the applied
condition colors.
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Phrase Search Filter
You can use the Micro Content Editor's search filter field under the local toolbar to quickly locate a
particular phrase. Clearing the filter field will again show all phrases.

EXAMPLE Following is a micro content file containing many phrases.

CHAPTER 2  19



Let’s say you want to see only the phrases containing the word “topic.” In that case, you
would type topic into the search bar and the phrases would immediately be limited to
those with that word.

After removing the word “topic” from the search bar, the full set of phrases is shown again.
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Grid
In the grid, you can do any of the following to manage your phrases and alternate phrases:

n Expand Entry You can double-click a main phrase to expand it, thus showing any linked files
or alternate phrases below it. Alternatively, you can click to the right of the phrase, which
then changes the button to .
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n Add Alternate Phrase To the right of the appropriate main phrase, click . This adds a new
alternate phrase under the main phrase. Replace the generic text with your own alternate
phrase.

You can also right-click in the grid and select Add Alternate Phrase from the context menu.
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n Delete Phrase To the right of the phrase, click . For alternate phrases, this button appears
to the right only when you hover over that alternate phrase.

You can also right-click in the grid and select Delete Phrase from the context menu.
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n Set as Main Phrase Right-click an alternate phrase that you want to be used as the question
in an FAQ proxy. Then, select Set as Main Phrase. This becomes the first (main) phrase, and
the previous main phrase becomes an alternate.
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n Link File to Phrase After expanding a phrase in the grid, click Add Link. In the dialog, find and
select a topic or snippet to be used as the response for that phrase. You can also choose a
bookmark within the linked file; in that case, the response will include any content after the
point of that bookmark in the file.

You can also right-click in the grid and select Add Link from the context menu.
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n Remove Link Under the main phrase, click . The link is removed from the phrase, but the
content in the response area to the right remains after being converted to text.

You can also right-click in the grid and select Remove Link/Convert to Text from the context
menu.
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n Select New Link Right-click on a phrase that is linked to a file and choose Select New Link. In
the dialog, find and select a topic or snippet to be used as the response for that phrase,
instead of the currently linked file.
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n Open Linked File Under the main phrase, click on the name of the topic or snippet that is
linked. That file opens in the XML Editor so that you can edit it.

You can also right-click in the grid and select Open Link from the context menu.
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Properties
You can edit properties for each micro content phrase by right-clicking the phrase in the Micro
Content Editor and selecting Properties.

In the dialog, you can do the following:

n "Editing Micro Content Phrase IDs" on page 198

n "Editing Micro Content Phrase Titles" on page 201

n "Including or Excluding Micro Content Phrases in Search" on page 204

n Setting and Overriding Meta Tag Values and Creating Custom Meta Tags (see "Micro Content
and Meta Tags" on page 42)

n "Single-Sourcing Micro Content Using Conditions" on page 206

n "Single-Sourcing Micro Content Using Variables" on page 239
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Micro Content Phrase Shortcuts
ENTER/SPACE Performs the action reached via the TAB key

LEFT/RIGHT Collapses/expands the phrase row

SHIFT+TAB Cycles backward through the buttons in a phrase row

TAB Cycles forward through the buttons in a phrase row

UP/DOWN Moves up and down from one phrase row to another
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Micro Content Phrase Tips
Here are a few things to keep in mind when working with phrases:

n Exactness of Phrases What if a user enters search text that is close to your micro content
phrase, but the wording is not exact? For example, maybe your phrase is “create widget” but a
user enters “creating widget.” Fortunately, Flare uses a scoring mechanism behind the scenes
that allows for slight differences between a phrase and the text entered in a search. To
account for searches that are not close enough to be handled automatically by Flare’s
calculation, you should create alternate phrases. There isn’t a way to measure this
beforehand; you simply need to test your output and adjust your micro content accordingly.

n Search Rankings If you create micro content, Flare considers only the text in the phrases and
alternate phrases for the micro content search results. The content in the response
associated with each phrase is not weighed. So the response that is paired with the phrase
most closely matching the search query (or having the most weight) is used. If you want to
help boost a particular micro content phrase/response so that it displays when a certain
search term is used, you can add more keywords to the phrase or alternative phrases for that
response.

n Synonyms If you create micro content, synonyms can help display the best search results.
The search engine looks at the micro content phrases and alternate phrases that you have
added to a file, but it also considers any relevant synonyms.

EXAMPLE You add the phrase "couch" to a micro content file, but you do not add any
alternate phrases. However, you have previously created a directional synonym for
"sofa" that matches the term "couch."

In your HTML5 output, a user searches for "sofa," and the micro content response
associated with the term "couch" is displayed.
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n Analytics The response part of micro content is important, because it contains the
information that the reader needs. However, the initial phrase (or search term) portion of
micro content can be just as important. After all, the response will be completely useless if
users never encounter it. It is vital that you begin with the correct phrases (or questions).

So how can you be sure you are using the right phrases? You could just rely on educated
guessing, or perhaps you created a glossary some time ago that gives you an idea of what
users might want to know about. But a better approach is to use analytics on your output,
such as MadCap Central, Google Analytics, or some other resource. After looking at reports
of the most commonly used search keywords, you can create micro content with the same
phrases. Central’s analytics feature is particularly useful because it has a “Phrases” report
that indicates whether a certain search term is associated with micro content in your project.
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Micro Content Responses
For each micro content phrase, you need a response, which is what the end user sees after
performing a search, interacting with a chatbot, etc. You can enter a response directly on the right
side of the Micro Content Editor, which works like a light version of the XML Editor. You can also
use an existing topic or snippet (or part of it) as the response by linking to it. Another method is to
select content in a topic or snippet and turn it into a micro content response. If you decide to enter
content directly into the Micro Content Editor, you can use toolbar buttons for certain features. You
can also use some options in the ribbons to insert other features (e.g., lists); the local toolbar
simply contains buttons for some of the most frequently used features.

Micro Content Response Toolbar
Opens the Conditional Text dialog, which lets you associate condition
tags with a response while you edit it. This is similar to the feature that
you can use to preview a document with certain conditions set. The
difference is that this associates the conditions to the response as you
edit it.

Clicking the down arrow on this button lets you select a medium or
media query so that you can view the topic with a specific set of styles.

Opens the Insert Hyperlink dialog, which lets you insert a text hyperlink
on the selected text.

Opens the Insert Cross-Reference dialog, which lets you insert a cross-
reference at the location of the cursor.

Opens a dialog, if you click the face of the button. You can use this
dialog to insert an image. If you click the down arrow on the button, a
drop-down opens, where you can access your pinned images and
recently used images.
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Opens the Insert Snippet Link dialog, if you click the face of the button.
You can use this dialog to insert a snippet. If you click the down arrow
on the button, the Insert Snippet drop-down opens, where you can
access your pinned snippets and recently used snippets.

Opens the Variables dialog, if you click the face of the button. You can
use this dialog to insert a variable. If you click the down arrow on the
button, a drop-down opens, where you can access your pinned variables
and recently used variables.

Opens the Character dialog, if you click the face of the button. You can
use this dialog to choose a character to insert or perform many other
tasks. If you click the down arrow on the button, you can select other
options, such as inserting a quick character or choosing one of your
favorite or recent characters.

Turns paragraph and space markers on and off. When you turn this
feature on, you can see markers that show where paragraphs end and
where space exists before and after content.

If you click the face of this button, all of the content changes, showing
the XML tags surrounding the content. If you click the down arrow, you
can select various other options.

For content entered directly in the editor (as opposed to linked to a file),
this button expands all tags in the editor (i.e., blocks of content), so that
you can see any content that was previously collapsed.

For content entered directly in the editor (as opposed to linked to a file),
this button collapses all heading tags in the editor (and the content
under them). An ellipsis icon displays under the main heading. As an
alternative to collapsing all tags, you can hover to the left of each block
of content and click the angled arrow to collapse just that part.
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Micro Content Response Right-Click Menu
If a micro content phrase is linked to a topic or snippet file, the response area is read-only. If you
right-click the linked content, you can do a few different things.

n Remove Link/Convert to Text The link is removed from the phrase, but the content in the
response area to the right remains after being converted to text.

n Select New Link In the dialog, find and select a topic or snippet to be used as the response for
that phrase, instead of the currently linked file.
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n Open Linked File The linked file opens in the XML Editor so that you can edit it.
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Micro Content Response Methods—Pros and
Cons
When creating a response, you can do so using a few different methods, and each has pros and
cons.

Method Pros Cons

"Response
Method 1:
Creating Micro
Content From a
Topic" on page
88

n You are linking to existing
content, rather than creating
new content.

n You can be more specific with
the response than the other
linking methods.

n A link to the corresponding
topic is automatically added
to the bottom of the featured
snippet in the search results.

n Some content contained in a
topic might look just fine as a
standalone micro content
response. However,
sometimes you might find the
need to make edits to that
content first.

"Response
Method 2:
Linking Phrases
to Entire Topics
or Snippets" on
page 94

n You are linking to existing
content, rather than creating
new content.

n A link to the corresponding
topic is automatically added
to the bottom of the featured
snippet in the search results.

n Linking to some topics (even
using a bookmark) might be
too much content for a micro
content response.

n If you link to a snippet, you will
not see an automatic link at
the bottom of the search
results, like you would see
when linking to a topic.

"Response
Method 3:
Linking Phrases
to Bookmarks"
on page 95

n You are linking to existing
content, rather than creating
new content.

n A link to the corresponding
topic is automatically added
to the bottom of the featured
snippet in the search results.

n Although this method lets you
be more specific than linking
to an entire topic, it will still
include everything after the
bookmark to the end of the
topic, and that might be too
much content.
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Method Pros Cons

"Response
Method 4:
Entering
Responses
Directly in the
Micro Content
Editor" on page
96

n This method is simple. Just
start adding content in the
editor.

n Unless you are inserting links
to separate files (e.g.,
snippets, images) in the Micro
Content Editor, you are not
single-sourcing if that same
content exists elsewhere in
the project.

n You don’t have as many
options as you do in a topic or
snippet. For example, you
cannot add a responsive
layout directly in the Micro
Content Editor, but you can
copy content such as this
from a topic or snippet into
that editor.
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Micro Content Response Tips
Here are a couple of things to keep in mind when creating your response content:

n Keep It Relatively Short Remember that micro means “small.” Flare lets you add lots of
different things to micro content (e.g., paragraphs, lists, steps, images, animated gifs, videos,
links, tables), the same kind of content you can add inside a topic. But that doesn’t mean that
you should add lots of content. Try to keep your micro content as short as possible, while not
sacrificing necessary information. If extra content becomes necessary to provide useful
information, you can use techniques such as drop-downs to condense the response.

In the Skin Editor, you can set a maximum size for containers in the output. You can also
change the view mode for containers, selecting between Drop-Down, Plain Text, or Truncated.

If a response exceeds the height in the output (and the container is shown in Truncated view),
an arrow button lets users expand and collapse the content that is not initially shown.
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n Responsive Structure Depending on the subject matter, you might want to structure a
response to show text on one side and something else—such as an image, animated gif,
video, or table—on the other side. If you do this, you might consider using a responsive layout
for the structure, so that the different elements stack on top of one another when viewed on a
small screen.

In the output, the image in the above example will display to the right of the steps, but on a
smart phone, the image will display below the text.

CHAPTER 2  41



Micro Content and Meta Tags
A meta tag is a type of metadata that you can use in MadCap Flare files for search engine
optimization (SEO) and content management.

You can integrate text or list meta tag types with micro content to manipulate how your micro
content displays as search results or as targeted content in specific topics in your output. This is
achieved by associating content with meta tags and creating micro content for it.

For example, when you implement any of the micro content containers in your output (featured
snippets, Knowledge Panel, micro content proxies), you will see options that let you select meta tag
names and values that you've set up. See "Micro Content Containers and Proxies" on the next page.

To gain a better understanding of meta tags and how they might be used with your micro content,
we recommend you walk through the following tutorials (see the online Help to access them):

n Meta Tags Tutorial

n Micro Content Tutorial—Advanced
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Micro Content Containers and Proxies
The most common—and easiest—way to use micro content in Flare is to display that content in
containers in output.

Easy "Baked-In" Containers
You can include micro content in HTML5 search results via the Target Editor, through the use of the
featured snippets and the Knowledge Panel containers. It could be said that both of these
containers are "baked in" to the output, which means that the options are somewhat limited but the
implementation is quite easy.

n Featured Snippets Micro content that is created in a Flare project can result in custom
"featured snippets" in your HTML5 output’s search results. This content is displayed above
the search results, and is one of the easiest, most immediate methods to use micro content
from Flare. You can use a filter to specifically determine which micro content might display
as featured snippets. You can also change its view mode (Plain Text, Truncated, or Drop-
Down) in your HTML5 skin. See "Featured Snippets" on page 98.

n Knowledge Panel Micro content can be displayed in HTML5 search results in an area called
the "Knowledge Panel." By default, this panel displays on the right side of the search results
page. However, you can edit the skin to display it on the left side or in the middle (above the
featured snippets and regular search results). You can also change its view mode (Plain Text,
Truncated, or Drop-Down) in your HTML5 skin. See "Knowledge Panel" on page 102.
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Advanced Containers Using Proxies
By using more advanced micro content proxies (FAQ, Knowledge, Promotion), you have even more
choices and control over your micro content.

n FAQ Proxy The FAQ proxy lets you generate a list of phrases and responses for the selected
micro content file(s) in most outputs. Results are static, based on specific criteria selected
when the target is built, not on the search engine output. This type of proxy is ideal for
including traditional FAQs, but it can be used for other purposes as well. See "FAQ Proxy" on
page 107.

n Knowledge Proxy The Knowledge proxy lets you display filtered micro content items in
HTML5 output. Results are dynamic, generated at runtime in the browser, using search
engine rankings. You might use a Knowledge proxy to display content such as information
about a person, a company, technical specifications, related tasks, etc. See "Knowledge
Proxy" on page 113.

n Promotion Proxy The Promotion proxy lets you display random micro content items in
HTML5 output. Results are dynamic, generated at runtime in the browser, using the search
engine. You might use a Promotion proxy to display information about relevant products,
events, new features, etc. See "Promotion Proxy" on page 117.

TIP The FAQ, Knowledge, and Promotion proxies are named for the types of purposes that
best fit their design. However, don't let the names limit you. Instead, it might be better to
think of these proxies as simply containers that hold whatever kind of information you
want. These three proxies have similar characteristics, but they have unique ones as well,
so let those help drive your decisions.
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EXAMPLE In the MadCap Flare online Help, we used an FAQ proxy to display links to
related resources (PDFs, videos) on the right side of topics. Obviously, these resource links
are not FAQs. However, the characteristics of that proxy (e.g., static, ability to sort in
alphabetical order) fit our needs better than the other two proxies.
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Dynamic vs. Static Proxies
One of the most important characteristics of a micro content proxy is whether it is dynamic or
static.

n Dynamic (Knowledge and Promotion) The micro content results are not determined until
runtime and rely on the search engine. Dynamic micro content might be easier to set up and
manage in some cases, because the "best" content (according to search rankings) is
automatically going to be used when and if your output content changes.

n Static (FAQ) You can select specific pieces of micro content for the results, which are
compiled when the target is built. So static micro content gives you confidence that only
certain pieces of information are included in the results because you choose them ahead of
time.

Proxies in Search Results vs. Topics
Since the Knowledge and Promotion proxies use the search engine to display results, they can be
displayed in search results or in topics (usually via a template page). FAQ proxies, which are static,
are really designed to be included in topics or template pages, not in search results. If you would
like to include an FAQ-like element in search results, you might consider inserting a Knowledge
proxy and using Drop-Down as the view mode in the skin.

To include proxies in search results, do this: Add a new topic, remove the unnecessary text, and
insert a Search Results proxy. You can then insert additional micro content proxies in that same
topic.
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Micro Content Proxies Comparison
By comparing the characteristics of each micro content proxy, you can better decide which fits a
particular need.

FAQ
Proxy

Knowledge
Proxy

Promotion
Proxy

Dynamic (Search Engine in Output)

Static (Build Time with Target)

Good for Search Results

Good for Topics and Template Pages

Randomized Results

Filter by Topic Title

Filter by Search Query

Filter by Meta Tag Value

Filter by Custom Text

Display Multiple Pieces of Micro Content in
Same Container

(Even From Different Micro Content Files)
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FAQ
Proxy

Knowledge
Proxy

Promotion
Proxy

Limit Number of Results to Display on Page

Sort Alphabetically

Structured Data for Google Results

Supported in HTML5 and Other Output Formats
Too

Supported in HTML5 Only

Default View Mode (Set in Skin) Drop-
Down

Truncated Plain Text
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Micro Content Proxy Examples
Following are some quick examples showing micro content proxies in the output.
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Responsive Layouts and Micro Content Proxies
To control the location of micro content added via proxies, you might consider using responsive
layouts, as was done in the examples shown above. This type of approach—which lets you position
micro content to the right or left of topic content or search results—is described in the Micro
Content Tutorial—Advanced.

Keep in mind that if you use a responsive layout to display micro content proxy information on the
same side of the search results as a Knowledge Panel, both will be shown side-by-side.
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Possible Use Cases for Micro Content
Containers
Following are some possible use cases for the various types of micro content containers. In some
situations, you might be able to use a particular container that doesn't have a check mark. This
table simply shows the containers you are most likely to use for a particular use case.

Featured
Snippets

Knowledge
Panel

FAQ
Proxy

Knowledge
Proxy

Promotion
Proxy

Author Attribution
in Topics

Content in Search
Results (Located
in Middle-Top)

Content in Search
Results (Located
on Left or Right)

FAQs in Search
Results

FAQs in Topics

Marketing of
Products or
Services

Product Warnings
and Labels in
Topics
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Featured
Snippets

Knowledge
Panel

FAQ
Proxy

Knowledge
Proxy

Promotion
Proxy

Random Tips

Resources Related
to Each Topic
(e.g., PDFs,
Videos)

Technical
Specifications in
Topics

Troubleshooting
Info in Topics

What’s New
Related to Topics
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Controlling the Look of Micro Content
Containers
For HTML5 targets, you can use a full HTML5 skin to edit the look and behavior for all of these
micro content elements. Alternatively, for the proxies, you can use separate micro content skin
components (FAQ, Knowledge, Promotion) if you want to have different settings for various
instances of a proxy in your project. Keep in mind that for non-HTML5 targets (i.e., PDF, Word,
Clean XHTML, Eclipse, EPUB, HTML Help), you need to use the FAQ skin component (rather than a
full skin) to control the look.

You can also use MadCap-specific styles in your stylesheet to change the look of the containers
used for micro content proxies.

See "Editing the Look of Micro Content" on page 128.
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Micro Content and Snippets
Micro content has a relationship with regular Flare snippets in a few ways.

Featured Snippets
Micro content that is created in a Flare project can result in custom "featured snippets" in your
HTML5 output’s search results. This content is displayed above the search results, and is one of the
easiest, most immediate methods to use micro content from Flare. You can use a filter to
specifically determine which micro content might display as featured snippets. You can also
change its view mode (Plain Text, Truncated, or Drop-Down) in your HTML5 skin.

Even though "featured snippet" is a phrase used to describe this one type of micro content, it is not
the same as a Flare snippet. The word "snippet"—when talking about featured snippets—was
adopted from Google and is just a coincidence.

As with some of the rich objects that you see on a Google search page, the featured snippets in
Flare output appear above regular search results, thus making them especially valuable. In other
words, you can always ensure that this targeted information is seen before anything else, rather
than buried among the rest of the results.

See "Featured Snippets" on page 98.

Linking to Regular Snippets
When creating micro content, one of the methods you can use is to link a phrase to a regular Flare
snippet in the project.

See "Response Method 2: Linking Phrases to Entire Topics or Snippets" on page 94.
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Inserting Regular Snippets
Another way to create a micro content response is to enter content directly in the Micro Content
Editor. This can include inserting regular Flare snippets in the editor, just as you would in a normal
topic.

See "Response Method 4: Entering Responses Directly in the Micro Content Editor" on page 96.
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Micro Content Features Per Output
Type

Following are micro content features supported in each output type.

HTML5 PDF Word
Clean
XHTML

Eclipse
Help EPUB

HTML
Help

Micro
Content
Supported

FAQ Proxy

Field-Level
Context-
Sensitive
Help

Featured
Snippets

Knowledge
Panel

Knowledge
Proxy

Promotion
Proxy
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HTML5 PDF Word
Clean
XHTML

Eclipse
Help EPUB

HTML
Help

Single-
Sourcing
Micro
Content

1Micro content in search is supported for HTML5 only if you are using Elasticsearch or
MadCap Search, but not Google Search.

2Only HTML5 supports all micro content features (e.g., featured snippets, Knowledge
Panel, Knowledge proxy, Promotion proxy, FAQ proxy). The other output formats support
only the FAQ proxy.
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What the MadCap Doc Team Does for
Micro Content

The MadCap documentation team currently do not use micro content for chatbots or other
applications that require extra programming outside of a Flare project. However, we do display
micro content in various containers for search results, as well as for topic output. Our approach
involves the following.
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Analytics
Our projects are integrated with MadCap Central, which gives us access to analytics on our
outputs. We sort the Phrases report to see which terms end users are entering most often for
searches.
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We also use a filter to show only the terms for which we do not yet have micro content (i.e., an X
indicates no micro content exists yet, and a check mark shows keywords for which we have already
created micro content) . This makes it easier for us to prioritize the creation of new micro content
phrases and responses.

Although some of our micro content is created proactively (i.e., as we write topics), we rely heavily
on analytics results to help us provide responses for queries that users are entering most, and to fill
in missing gaps.
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Number of Micro Content Files
We decided to make multiple categories of micro content files for each product, storing them in a
Resources > MicroContent subfolder.
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n Cheat-Sheet-Links, Tutorial-Links, User-Guide-Links Each of these micro content files holds
simple links to the various PDFs that we publish. These pieces of micro content are displayed
in relevant topics.

n Definitions This micro content file holds simple definitions, sometimes with an image
included, but usually not. The micro content is displayed in search results.
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n Mini-Landing-Pages We discovered that the vast majority of search phrases in our reports are
simply words or short phrases (e.g., skin, template pages, output), rather than actual
questions or even phrases containing a verb. Therefore, we created a micro content file and
named it “Mini-Landing-Pages.” Since these search phrases are somewhat vague (e.g., if
people search for “skin,” we don’t know which aspect of skins they want to know about), the
responses associated with the micro content phrases are designed to be mini landing pages,
containing a short snapshot of the subject. This usually includes drop-downs with links to
processes, tasks, or other information that we think the user is most likely trying to find.
Sometimes we also include a visual element with it.
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n Promotions For certain topics that are affected by a new release of Flare, we wanted to be
able to display a small object alerting users to this. We also wanted to provide users with a
quick way to learn more about another MadCap Software product, if the topic talks about it.
For these pieces of micro content, we created a file called "Promotions.
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n Quick-Steps When viewing analytics, we noticed phrases containing verbs (e.g., apply
condition tag, import Word), indicating that users are trying to find information on how to
complete a specific task. Therefore, we created a micro content file and named it “Quick-
Steps.” The response for each of these micro content phrases is a very brief set of steps,
usually a shortened version of the main topic for that task. It also often includes a visual
element, such as an image or animated gif.
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n Videos-Featured-Snippets For our YouTube videos, we created a micro content file called
"Videos-Featured-Snippets," which contains small pieces of micro content showing a small
image, link to a video, the date it was created, and its length. These video links are shown in
the search results in the featured snippets area at the top.
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n Videos-Side-Links Finally, we have a second micro content file dedicated to video links, called
"Video-Side-Links." These links display alongside any PDF links in topic output.
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Structure of Responses
In some cases, we wanted to include both text and either multimedia or images in our topics and
micro content responses. We wanted the text to appear on the left or top (if the screen or container
was large enough), and the multimedia or image on the right or bottom. Therefore, we decided to
create some different responsive layouts; this allows the content to stack when viewed on a small
screen or if the micro content container is too narrow to display it side-by-side.
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Containers
For our search results, we edited our HTML5 target so that YouTube videos would be the only
pieces of micro content to display in the featured snippets area. For the Knowledge Panel on the
right, we told our target that it could select the best match it found from one of three micro content
files (Definitions, Mini-Landing-Pages, or Quick-Steps.)

For micro content displaying in topic output, we created a responsive layout in our template page.
In the cell on the right of that layout, we inserted several micro content proxies. Some proxies are
for our Flare documentation, and other proxies are designated for other product documentation,
with conditions applied to them. For each product, we used four proxies in the template page, and
we connected them to meta tags that we created in meta tag sets.
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n First Promotion Proxy Displays what's new information for specified topics.
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n First FAQ Proxy Displays PDF links for specified topics.
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n Second FAQ Proxy Displays Video links for specified topics.
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n Second Promotion Proxy Displays information about other products for specified topics.
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Skin Styles
We used our main skin and a couple of micro content skin components to control a variety of
elements, such as:

n View mode

n Margins

n Padding

n Box shadow
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Response Links From Topics and Single-
Sourcing Content
In the vast majority of cases, we create micro content from selected text within a topic. This lets us
single-source content while automatically including a link back to the topic in the search results.

We also created some special styles that let us hide content in the micro content response, while
displaying all of the content in the full topic. In addition, we have styles for changing the look of
content when shown in the micro content response (e.g., less space between steps). The idea is
that the micro content response should be a smaller representation of what a user sees in the full
topic, without having to create two sets of content. See "Single-Sourcing Micro Content Using
Styles" on page 217.
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MICRO CONTENT RESPONSE
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FULL TOPIC
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CHAPTER 3

Process for Micro Content
Certain tasks must be completed in order when using this feature.

This chapter discusses the following:

Creating Micro Content 83

Implementing Micro Content 97

Editing the Look of Micro Content 128
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Creating Micro Content
The first step in using micro content, for whatever purpose, is to create it in Flare. This entails
adding a micro content file to the Content Explorer and then adding phrases and responses within
it. This can be done using a few different response methods (see "Micro Content Response
Methods—Pros and Cons" on page 37).
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Adding a Micro Content File to a Project
You can add as many micro content files to your project as you need. Some authors might just
need one micro content file, but others might create multiple micro content files for organizational
purposes, storing different "categories" of phrase/response combinations in each one.

How to Add a Micro Content File
1. (Optional) Create a subfolder to store a micro content file.

a. Select View > Content Explorer.

b. In the Content Explorer, select the Resources folder.

c. In the local toolbar, click . A folder with the temporary name "NewFolder" is added.

d. Type a new name for the folder (we recommend using MicroContent as the name) and
press ENTER.

2. Right-click on your Resources > MicroContent folder (or whatever you have named it) and
from the context menu select New > Micro Content. The Add File dialog opens.

3. In the File Name field, type a new name for the micro content file.

4. Click Add. The micro content file is added to the Content Explorer. The Micro Content Editor
opens to the right, displaying micro content phrases on the left and an area to the right for the
response. There is one phrase/response already added, which you can remove or
rename/replace.
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Creating Main Phrases in the Micro Content
Editor
Each main phrase that you create should become associated with a response.

The following steps should be completed if you are using one of these methods:

n "Response Method 2: Linking Phrases to Entire Topics or Snippets" on page 94

n "Response Method 3: Linking Phrases to Bookmarks" on page 95

n "Response Method 4: Entering Responses Directly in the Micro Content Editor" on page 96

If you are using "Response Method 1: Creating Micro Content From a Topic" on page 88
(recommend in most cases), you do not need to complete the following steps, because you will
create the main phrase at the same time that you select the response content.

How to Create Main Phrases
1. From the Content Explorer, open the micro content file.

2. In the local toolbar of the Micro Content Editor, click . A new row is added to the phrase
area on the left, with "New Phrase" shown as the default name.

3. Type your phrase and press ENTER on the keyboard.

4. Click to save your work.
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Creating Alternate Phrases in the Micro Content
Editor
Not only can you create main phrases, but you can also add alternate phrases for each main
phrase, regardless of the method you use. Alternate phrases are extremely useful because it is
impossible to predict the phrasing a person will use. By adding alternate phrases, you are improving
the odds that the matching response will display in most circumstances.
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How to Create Alternate Phrases
1. From the Content Explorer, open the micro content file.

2. To the right of the main phrase, click . A new row is added below the main phrase, with
"New Phrase" shown as the default name.

3. Type your phrase and press ENTER on the keyboard.

4. Repeat these steps to create more alternate phrases.

5. Click to save your work.

NOTE The main phrase does not carry more weight than any of the alternate phrases. They
are simply a way to connect to the same response as the main phrase.

CHAPTER 3  87



Response Method 1: Creating Micro Content
From a Topic
You can create micro content (both the main phrase and response) from a topic. The great benefit
of using this approach is that you can choose a specific block of existing content that will be used
as the response. In most cases, this is the recommended method.

How to Create Micro Content From a Topic
1. Open the topic.

2. Do one of the following:

n Select the content that you want to use as a response for a micro content phrase. Then
in the Home ribbon, click Create Micro Content.

CHAPTER 3  88



n Right-click selected content, or the structure bar to the left of the content, that you want
to use as a response for a micro content phrase. From the context menu, select Create
Micro Content.
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TIP If you have several different elements that you want to select (e.g., paragraph,
list, image), it sometimes helps to first place all of that content in a <div> tag, then
choose that div structure bar when creating the micro content.

The Create Micro Content dialog opens.

3. In the Phrase field, enter the text that a user would enter to make the response appear as a
result in the output.

NOTE After you have finished, you can open the Micro Content Editor and add
alternative phrases to be associated with the response as well.

4. (Optional) You can also click if you want to insert a variable as the entire phrase, or as part
of the phrase. The following syntax for the variable will be used:
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5. If you have more than one micro content file in your project, use the Micro Content File field
to select it.
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6. Click OK.

The micro content file will be updated with your new phrase linking to that content.
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Also, you might notice that the selected content in the topic is now wrapped in a special
<MadCap:microContent> tag.

7. Click to save your work.

In the output, when a person uses your phrase (or something close to it) to look for information, the
selected content will display by itself as a result, even if the topic has other content above or below
it in the source file.

CHAPTER 3  93



Response Method 2: Linking Phrases to Entire
Topics or Snippets
You can link a phrase to a topic or snippet. This lets you reuse existing content, but often topics and
snippets are larger than ideal for micro content. One solution to this dilemma is to exclude some of
the content from the micro content response (see "Single-Sourcing Micro Content Using Styles" on
page 217), a technique that can be used for the other methods as well.

How to Link Phrases to Entire Topics or Snippets
1. From the Content Explorer, open the micro content file.

2. If necessary, click to the right of the main phrase. This expands the area below the phrase.

3. Click Add Link.

4. In the Select File dialog, locate and select the topic or snippet.

5. Click OK. The response content is shown to the right, but it is read-only since it is linked. In
order to edit the content, you need to edit the topic or snippet.

6. Click to save your work.
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Response Method 3: Linking Phrases to
Bookmarks
By linking a phrase to a bookmark in a topic or snippet, the micro content in the output will display
all of the content that is found after that bookmark. None of the content above it will be seen.

How to Link Phrases to Bookmarks
1. From the Content Explorer, open the micro content file.

2. If necessary, click to the right of the main phrase. This expands the area below the phrase.

3. Click Add Link.

4. In the Select File dialog, locate and select the topic or snippet.

5. Click . Then find and select the bookmark in the dialog and click OK.

6. In the Select File dialog, click OK. The response content is shown to the right, but it is read-
only since it is linked. In order to edit the content, you need to edit the topic or snippet.

7. Click to save your work.
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Response Method 4: Entering Responses
Directly in the Micro Content Editor
Single-sourcing is the best practice when working in Flare. Therefore, if you already have some
content elsewhere in your project, it is not generally recommended that you re-enter that content as
a response directly in the Micro Content Editor. However, it could be argued that inserting snippets
or images in the Micro Content Editor is acceptable, since those files exist separately and can be
managed from one location.

How to Enter Responses Directly in the Micro Content
Editor

1. From the Content Explorer, open the micro content file.

2. On the left, select a phrase to associate with the response.

3. In the area to the right, enter text, snippets, images, and other features, just as you would edit
a topic or snippet.

4. Click to save your work.
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Implementing Micro Content
After creating a micro content file with phrases and responses, you need to implement it using one
or more of the features available in Flare.

Setting Micro Content Containers
Flare provides various container types that you can use to add micro content to your HTML5
output. Some of these can be used in search results, some in topic output, and some in both. See
the online Help for more information.
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Featured Snippets
In Google searches, you have undoubtedly seen objects that are known as “Google Search Engine
Results Page (SERP) features” that display on the page with regular search results. There are all
kinds of SERP features that you come across from time to time. One of these is called a “featured
snippet,” which provides an answer to a query, such as “Ways to get more YouTube subscribers.”

Micro content that is created in a Flare project can result in custom "featured snippets" in your
HTML5 output’s search results. This content is displayed above the search results, and is one of the
easiest, most immediate methods to use micro content from Flare. You can use a filter to
specifically determine which micro content might display as featured snippets. You can also
change its view mode (Plain Text, Truncated, or Drop-Down) in your HTML5 skin.
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As with some of the rich objects that you see on a Google search page, the featured snippets in
Flare output appear above regular search results, thus making them especially valuable. In other
words, you can always ensure that this targeted information is seen before anything else, rather
than buried among the rest of the results.

Although these are referred to as “featured snippets,” don’t confuse them with the regular snippets
in a Flare project. As you will see, micro content can be created with the help of regular snippets,
but that is purely optional.
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How to Set Featured Snippet Target Options

1. Open an HTML5 target.

2. Select the Search tab.

3. At the top of the page, make sure the Search Engine Type is set to MadCap Search or
Elasticsearch. (Micro content from Flare is not supported with Google Search selected.)

4. In the Featured Snippets section, click the Filter drop-down and select one of the options.

n Do not include in search results No micro content is included in the featured snippets
area.

n All micro content files Every phrase from all of your micro content files may be
included.

n Specific micro content files In the drop-down(s), choose one or more micro content
files. Every phrase from those files may be included.

n Micro content with meta tags In the additional drop-down(s), choose specific meta tag
names and corresponding values. Micro content phrases that match may be included.
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5. (Optional) In the Limit number of results field, you can enter a number. For example, if you
leave it set at 1, Flare will display only the best match from your micro content file(s). If you
enter 3, Flare will display up to the best three matches (if that many exist).

6. Click to save your work.

NOTE To create featured snippets for your search results, you need to be using either
Elasticsearch or MadCap Search as your search engine. Also, this feature is supported only
with HTML5 skins (Side Navigation, Top Navigation, Tripane), as well as skinless outputs.
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Knowledge Panel
Micro content can be displayed in HTML5 search results in an area called the "Knowledge Panel."
By default, this panel displays on the right side of the search results page. However, you can edit
the skin to display it on the left side or in the middle (above the featured snippets and regular
search results). You can also change its view mode (Plain Text, Truncated, or Drop-Down) in your
HTML5 skin.
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How to Set Knowledge Panel Target Options

1. Open an HTML5 target.

2. Select the Search tab.

3. At the top of the page, make sure the Search Engine Type is set to MadCap Search or
Elasticsearch. (Micro content from Flare is not supported with Google Search selected.)

4. In the Knowledge Panel section, click the Filter drop-down and select one of the options.

n Do not include in search results No micro content is included in the Knowledge Panel
area.

n All micro content files Every phrase from all of your micro content files may be
included.

n Specific micro content files In the drop-down(s), choose one or more micro content
files. Every phrase from those files may be included.

n Micro content with meta tags In the additional drop-down(s), choose specific meta tag
names and corresponding values. Micro content phrases that match may be included.
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5. (Optional) In the Limit number of results field, you can enter a number. For example, if you
leave it set at 1, Flare will display only the best match from your micro content file(s). If you
enter 3, Flare will display up to the best three matches (if that many exist).

6. Click to save your work.
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How to Change the Position of the Knowledge Panel

1. Open the HTML5 skin.

2. Select the Styles tab.

3. Expand Search Results and select Knowledge Panel.
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4. In the properties area, expand Position. Then select one of the options (left, right, middle).

5. Click to save your work.

NOTE There are other settings in the skin that you might decide to adjust as well (e.g., view
mode, size, border). See the online Help.
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FAQ Proxy
The FAQ proxy lets you generate a list of phrases and responses for the selected micro content file
(s) in most outputs. Results are static, based on specific criteria selected when the target is built,
not on the search engine output. This type of proxy is ideal for including traditional FAQs, but it can
be used for other purposes as well.
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For many more details about Flare's micro content proxies and containers, their possible uses, and
how they compare with each other, see "Micro Content Containers and Proxies" on page 43.
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How to Insert an FAQ Proxy

1. Open a topic or template page.

If you want the micro content to display in multiple topics, you will usually want to insert the
proxy into a template page so that it is automatically used by many (or all) topics. However,
you can insert the proxy into an individual topic if you want.

2. (Optional) If you want to position the micro content results in a particular on the page (e.g.,
right side), you might consider creating and inserting a responsive layout, with the proxy
inserted into the appropriate cell.

3. Select Insert > Proxy > FAQ Proxy.

4. (Optional) In the Proxy Title field, you can enter title text, which is displayed at the top of the
micro content.

5. If you have added an FAQ skin component to your project and want to use it to control the
look of the micro content container, you can select it from the Skin File field.

If you do not select an FAQ skin component in this field, Flare uses the first one it finds in
your project (if one exists). Otherwise, Flare uses the settings in your main HTML5 skin.

6. If you have created a separate stylesheet for micro content purposes, you can select Allow
micro content stylesheets. Otherwise, your main stylesheet will be used.

7. Click the What micro content to include drop-down, and select one of the options.

n All micro content files Every phrase from all of your micro content files may be
included.

n Specific micro content files In the drop-down(s), choose one or more micro content
files. Every phrase from those files may be included.

n Micro content with meta tags In the additional drop-down(s), choose specific meta tag
names and corresponding values. Micro content phrases that match may be included.

NOTE When you use this option with an FAQ proxy, make sure you also apply
the meta tag values to the appropriate micro content phrases in your micro
content files. That is how Flare knows which micro content responses to
display in the output.
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8. Click the How micro content is included drop-down, and select one of the options.

n All micro content Every micro content phrase meeting the criteria from the first filter
may be included in the results.

n Filtering by topic meta tag value In the additional drop-down(s), choose the meta tag
name associated with the micro content phrase, and then the matching meta tag name
associated with the topic. These might be identical but don’t need to be. Micro content
phrase/response combinations will be included according to this input.

NOTE When you use this option with an FAQ proxy, make sure you also apply
the meta tag values to the appropriate micro content phrases in your micro
content files. That is how Flare knows which micro content responses to
display in the output.

9. If you want the micro content to be displayed alphabetically according to the phrase, select
Sort phrases in alphabetical order.

10. Enable Generate FAQ structured data if you want Flare to add code to the <head> tag for
appropriate topics in the output.

This makes it possible for the micro content to be included as an FAQ rich result on a Google
search page. In other words, it has the potential to be a unique object separate from the rest
of the regular search results. Keep in mind that these results are at the discretion of Google
and not guaranteed.

This option is possible for the FAQ proxy, but not for the Knowledge or Promotion proxies.
The reason for this is that the micro content from an FAQ proxy is compiled at build time (i.e.,
when you generate the target). The micro content for the Knowledge or Promotion proxies
isn't compiled until action takes place in the output, and the search engine decides the
content to display.
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EXAMPLE You create some output about dogs, including an FAQ proxy on the Home
page that displays some FAQs.

Of course, this will always display in your own output when you open the topic.
However, you might also be able to turn this FAQ content into a rich result on Google
itself.
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If you enable Generate FAQ structured data in the FAQ proxy, you can see code
added to the <head> tag when you view the page source.

When a user performs a search on Google, this structured data makes it possible
(though not definite) that Google will display your FAQs as a rich result on a search
page.

For more information, see the Google developer website: 

https://developers.google.com/search/docs/advanced/structured-data/faqpage

11. Click OK. The proxy is added.

12. Click to save your work.
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Knowledge Proxy
The Knowledge proxy lets you display filtered micro content items in HTML5 output. Results are
dynamic, generated at runtime in the browser, using search engine rankings. You might use a
Knowledge proxy to display content such as information about a person, a company, technical
specifications, related tasks, etc.

For many more details about Flare's micro content proxies and containers, their possible uses, and
how they compare with each other, see "Micro Content Containers and Proxies" on page 43.
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How to Insert a Knowledge Proxy

1. Open a topic or template page.

If you want the micro content to display in multiple topics, you will usually want to insert the
proxy into a template page so that it is automatically used by many (or all) topics. However,
you can insert the proxy into an individual topic if you want.

If you want the micro content to display in search results, you need a topic where you have
also inserted a search results proxy.

2. (Optional) If you want to position the micro content results in a particular on the page (e.g.,
right side), you might consider creating and inserting a responsive layout, with the proxy
inserted into the appropriate cell.

3. Select Insert > Proxy > Knowledge Proxy.

4. (Optional) In the Proxy Title field, you can enter title text, which is displayed at the top of the
micro content.

5. If you have added a Knowledge skin component to your project and want to use it to control
the look of the micro content container, you can select it from the Skin File field.

If you do not select a Knowledge skin component in this field, Flare uses the first one it finds
in your project (if one exists). Otherwise, Flare uses the settings in your main HTML5 skin.

6. If you have created a separate stylesheet for micro content purposes, you can select Allow
micro content stylesheets. Otherwise, your main stylesheet will be used.

7. Click the What micro content to include drop-down, and select one of the options.

n All micro content files Every phrase from all of your micro content files may be
included.

n Specific micro content files In the drop-down(s), choose one or more micro content
files. Every phrase from those files may be included.

n Micro content with meta tags In the additional drop-down(s), choose specific meta tag
names and corresponding values. Micro content phrases that match may be included.
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8. Click the How micro content is included drop-down, and select the terminology method that
you want the search engine to use to match a micro content phrase, thus determining the
content results for the proxy.

n Topic title The title that is set automatically or manually in the topic properties (and
added inside the topic’s <head> tag) may be used in the results if it matches a micro
content phrase.

NOTE This option is useful primarily when inserting the proxy into a template
page or topic, as opposed to including it in search results. If you wanted to
include it in a custom search results page, you would want to make sure the
topic holding the Search Results proxy had the topic title in question added to
its properties.

n Search query The keyword(s) entered by the end user when performing a search may
be used if it matches a micro content phrase.

NOTE This option is useful primarily when inserting the proxy into custom
search results topic (which includes a Search Results proxy), as opposed to a
template page or topic. That's because the keyword relies on an actual search
performed by the end user in the output.

n Meta tag value The meta tag name that you select from a meta tag set file may be used
in the results if it matches a micro content phrase.

NOTE This option is useful primarily when inserting the proxy into a template
page or topic, as opposed to including it in search results.

When using this option, you should associate the topic(s) in question with a
value from the meta tag, and the micro content phrase should match that value
text.

If you want to include it in a custom search results page, make sure the topic
holding the Search Results proxy is associated with the meta tag value in
question.
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n Custom text Any text you provide in this field may be used in the results if it matches a
micro content phrase.

NOTE This option can be useful when inserting the proxy into a template page,
topic, or custom search results page. You would probably use this option if you
always wanted the same micro content phrase/response to be shown in the
output.

9. You can use the Limit number of results field to specify how many matching micro content
results are shown on the page.

10. Click OK. The proxy is added.

11. Click to save your work.
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Promotion Proxy
The Promotion proxy lets you display random micro content items in HTML5 output. Results are
dynamic, generated at runtime in the browser, using the search engine. You might use a Promotion
proxy to display information about relevant products, events, new features, etc.
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For many more details about Flare's micro content proxies and containers, their possible uses, and
how they compare with each other, see "Micro Content Containers and Proxies" on page 43.
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How to Insert a Promotion Proxy

1. Open a topic or template page.

If you want the micro content to display in multiple topics, you will usually want to insert the
proxy into a template page so that it is automatically used by many (or all) topics. However,
you can insert the proxy into an individual topic if you want.

If you want the micro content to display in search results, you need a topic where you have
also inserted a search results proxy.

2. (Optional) If you want to position the micro content results in a particular on the page (e.g.,
right side), you might consider creating and inserting a responsive layout, with the proxy
inserted into the appropriate cell.

3. Select Insert > Proxy > Promotion Proxy.

4. (Optional) In the Proxy Title field, you can enter title text, which is displayed at the top of the
micro content.

5. If you have added a Promotion skin component to your project and want to use it to control
the look of the micro content container, you can select it from the Skin File field.

If you do not select a Promotion skin component in this field, Flare uses the first one it finds
in your project (if one exists). Otherwise, Flare uses the settings in your main HTML5 skin.

6. If you have created a separate stylesheet for micro content purposes, you can select Allow
micro content stylesheets. Otherwise, your main stylesheet will be used.

7. Click the What micro content to include drop-down, and select one of the options.

n All micro content files Every phrase from all of your micro content files may be
included.

n Specific micro content files In the drop-down(s), choose one or more micro content
files. Every phrase from those files may be included.

n Micro content with meta tags In the additional drop-down(s), choose specific meta tag
names and corresponding values. Micro content phrases that match may be included.

8. Click the How micro content is included drop-down, and select the terminology method that
you want the search engine to use to match a micro content phrase, thus determining the
content results for the proxy.

n All micro content Every micro content phrase meeting the criteria from the first filter
may be included in the results.
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n Topic title The title that is set automatically or manually in the topic properties (and
added inside the topic’s <head> tag) may be used in the results if it matches a micro
content phrase.

NOTE This option is useful primarily when inserting the proxy into a template
page or topic, as opposed to including it in search results. If you wanted to
include it in a custom search results page, you would want to make sure the
topic holding the Search Results proxy had the topic title in question added to
its properties.

n Search query The keyword(s) entered by the end user when performing a search may
be used if it matches a micro content phrase.

NOTE This option is useful primarily when inserting the proxy into custom
search results topic (which includes a Search Results proxy), as opposed to a
template page or topic. That's because the keyword relies on an actual search
performed by the end user in the output.

n Meta tag value The meta tag name that you select from a meta tag set file may be used
in the results if it matches a micro content phrase.

NOTE This option is useful primarily when inserting the proxy into a template
page or topic, as opposed to including it in search results.

When using this option, you should associate the topic(s) in question with a
value from the meta tag, and the micro content phrase should match that value
text.

If you want to include it in a custom search results page, make sure the topic
holding the Search Results proxy is associated with the meta tag value in
question.

n Custom text Any text you provide in this field may be used in the results if it matches a
micro content phrase.
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NOTE This option can be useful when inserting the proxy into a template page,
topic, or custom search results page. You would probably use this option if you
always wanted the same micro content phrase/response to be shown in the
output.

9. You can use the Limit number of results field to specify how many matching micro content
results are shown on the page.

10. Click OK. The proxy is added.

11. Click to save your work.
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Using Micro Content for Chatbots and Other
Advanced Purposes
Some of the micro content features (e.g., featured snippets, Knowledge Panel, field-level Help) are
quite easy to create and use right away, but there are other potential uses for micro content as well.
The list of possibilities is limited only by your imagination and available resources. For example, you
might want to create a chatbot or even produce virtual and augmented reality instructions. To
accomplish either of these, you might need the assistance of an experienced programmer and/or
third-party applications.
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How to Use Micro Content for Advanced Purposes
Follow these steps if you want to use micro content in a chatbot or for another purpose that cannot
be produced completely from Flare.

1. After generating HTML5 output that includes micro content phrases and responses, you can
open the Project ribbon and click Open Output Folder.

2. In Windows, open your target folder, then double-click the MicroContent folder.
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This folder contains other subfolders, which you can open. In the subfolder named after the
micro content file, you will see HTML files named after your phrases, with the associated
responses contained inside.

3. At this point, a developer would need to do some extra programming and work outside of
Flare, pointing to the files in your MicroContent output folder as necessary. This person does
not need to be a Flare user or have a Flare license. This individual might find the need to use
third-party applications to complete the work.
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Micro Content and Context-Sensitive Help
You can set context-sensitive Help (CSH) identifiers (IDs) on micro content phrases, therefore
connecting the corresponding responses to specific parts of a software interface. And since micro
content is intended to be quite short, this makes it ideal for field-level Help, as opposed to say,
window- or dialog-level Help. Flare handles the connection between your micro content
phrase/response combinations and CSH IDs; however, to link these IDs to a desktop application,
your programmers would need to use whatever third-party software they normally use to complete
their part of the work.

The process of creating CSH for micro content is essentially the same as it is for topics.

n Author After assigning the IDs to the appropriate micro content phrases, you need to build the
output and make it available to the developer. You also need to share the header file with the
developer if you are responsible for creating it.

n Developer Based on the information in the header file, the developer associates the IDs with
each area of your software's interface. The developer can use a JavaScript or URL method.
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For additional details, see the online Help or the Context-Sensitive Help Guide.
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Editing the Look of Micro Content
For HTML5 targets, you can use a full HTML5 skin to edit the look and behavior for all of these
micro content elements. Alternatively, for the proxies, you can use separate micro content skin
components (FAQ, Knowledge, Promotion) if you want to have different settings for various
instances of a proxy in your project. Keep in mind that for non-HTML5 targets (i.e., PDF, Word,
Clean XHTML, Eclipse, EPUB, HTML Help), you need to use the FAQ skin component (rather than a
full skin) to control the look.

You can also use MadCap-specific styles in your stylesheet to change the look of the containers
used for micro content proxies.

NOTE It is also possible to use complex selectors in your stylesheet to make content look
different in micro content search results than it does in topics in the output.
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Editing Skins and Skin Components
Following are general steps for editing micro content in a skin or skin component, as well as
specific steps for some of the more common tasks.

How to Edit the Look of Micro Content in a Skin—
General Steps

1. Open an HTML5 skin or micro content skin component.

2. Select the Styles tab.

3. In the local toolbar, make sure Web Medium is selected.

4. On the left side of the editor, select the Search Results or Topic Proxies styles (if working in a
full skin), or expand them to select other nodes. In a micro content skin component, there is
only one style (Micro Content Panel) to select or expand.

5. In the properties area at the bottom, complete the necessary fields.

6. Click to save your work.

NOTE You can then select one of the other medium buttons (Tablet, Mobile) at the
top of the editor and complete settings for smaller screens.
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How to Change the View Mode in a Skin
Each micro content container type has a default view mode (Plain Text, Drop-Down, or Truncated).
You can select a different mode in the full skin or skin component (for proxies).

NOTE The styles and properties that are available in the skin can change, depending on the
view mode selected for that container type.

1. Open the HTML5 skin or skin component.

2. Select the Setup tab.

3. Click the drop-down next to the appropriate View Mode field (e.g., Knowledge Panel View
Mode, FAQ Proxy View Mode), and select one of the options.

n Plain Text The micro content will be displayed in full.

n Drop-Down The micro content will be displayed as a drop-down, with the phrase
serving as the hotspot and the response showing as the drop-down body.

n Truncated The micro content will be displayed according to the height set in the skin. If
the content is too tall for that area, a drop-down displays so that users can click it to
see the rest of the information.

4. Click to save your work.
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How to Change the Size in a Skin
You can change the width (and gap) for a Knowledge Panel. In addition, you can set the maximum
height for the response shown for all micro content container types.

NOTE If you want to change the maximum height property, first make sure it is set to the
Truncated view mode. Otherwise, the property will not be available.

1. Open the HTML5 skin or skin component.

2. Select the Styles tab.

3. On the left side of the editor, navigate to the appropriate node and make changes to the
properties.

If using a full HTML5 skin:

n Featured Snippets Response Go to Search Results > Featured Snippets > Item >
Response. In the properties area, expand Size and change the Maximum Height.

n Knowledge Panel Go to Search Results > Knowledge Panel. In the properties area,
expand Side Panel and change the Width and/or Gap.

n Knowledge Panel Response Go to Search Results > Knowledge Panel > Item >
Response. In the properties area, expand Size and change the Maximum Height.

n FAQ Proxy Response Go to Topic Proxies > FAQ Proxy > Item > Response. In the
properties area, expand Size and change the Maximum Height.

n Knowledge Proxy Response Go to Topic Proxies > Knowledge Proxy > Item > Response.
In the properties area, expand Size and change the Maximum Height.

n Promotion Proxy Response Go to Topic Proxies > Promotion Proxy > Item > Response.
In the properties area, expand Size and change the Maximum Height.

If using micro content skin component:

n FAQ, Knowledge, or Promotion Proxy Response Go to Micro Content Panel > Item >
Response. In the properties area, expand Size and change the Maximum Height.

4. Click to save your work.
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How to Change the Box Shadows or Borders in a Skin
By default, you will notice what looks like a border around the micro content containers that you
include in output. Actually, what you are seeing is a box shadow. You can adjust or remove this box
shadow, and you can also set a border. This can be done for the entire container or different parts
of the micro content.

1. Open the HTML5 skin or skin component.

2. Select the Styles tab.

3. On the left side of the editor, navigate to the appropriate node.

If using a full HTML5 skin:

n Featured Snippets Go to Search Results > Featured Snippets.

n Knowledge Panel Go to Search Results > Knowledge Panel.

n FAQ Proxy Go to Topic Proxies > FAQ Proxy.

n Knowledge Proxy Go to Topic Proxies > Knowledge Proxy.

n Promotion Proxy Go to Topic Proxies > Promotion Proxy.

If using micro content skin component:

n FAQ, Knowledge, or Promotion Proxy Go to Micro Content Panel.

4. You can then navigate to different sub-nodes to change border and box shadow settings. The
default box shadow settings can be found on the Item node. After you select a node, you can
expand Border or Box Shadow in the properties area and change the settings.

5. Click to save your work.
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How to Hide or Display the Phrase in a Skin
In some cases, the micro content phrase is displayed, as well as the response. However, you might
decide to hide the phrase in the output for some micro content.

NOTE The Layout node that is used to display or hide the phrase is only available if the
element is set to Plain Text or Truncated view mode. The phrase is necessary for Drop-
Down view mode (which is the default setting for the FAQ proxy), so the Layout node is not
available in the skin in that case; in other words, the phrase will always be shown as the
drop-down hotspot.

NOTE The title for a micro content proxy container can also be hidden. This can be done
using similar steps as below in the skin. However, you can also just leave the Title field
empty when inserting the proxy.

1. Open the HTML5 skin or skin component.

2. Select the Styles tab.

3. On the left side of the editor, navigate to the appropriate node.

If using a full HTML5 skin:

n Featured Snippets Go to Search Results > Featured Snippets > Item > Phrase.

n Knowledge Panel Go to Search Results > Knowledge Panel > Item > Phrase.

n FAQ Proxy Go to Topic Proxies > FAQ Proxy > Item > Phrase.

n Knowledge Proxy Go to Topic Proxies > Knowledge Proxy > Item > Phrase.

n Promotion Proxy Go to Topic Proxies > Promotion Proxy > Item > Phrase.

If using micro content skin component:

n FAQ, Knowledge, or Promotion Proxy Go to Micro Content Panel > Item > Phrase.

4. Expand Layout, and set the Display field to none (hidden) or block (displayed).

5. Click to save your work.
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Micro Content Proxy Styles
You can also use micro content proxy styles to control the look of those containers.
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How to Edit Micro Content Proxy Styles
1. From the Content Explorer, open the stylesheet that you want to modify.

2. In the local toolbar, make sure the first button displays . If the button displays
instead, then click it.

3. In the upper-left corner of the editor, click in the drop-down field and select
.

4. On the left side of the editor, find and select one of the expanding text styles:

n MadCap | faqProxy Modifies the FAQ proxy container holding micro content.

n MadCap | knowledgeProxy Modifies the Knowledge proxy container holding micro
content.

n MadCap | promotionProxy Modifies the Promotion proxy container holding micro
content.

5. From the Show drop-down list on the upper-right side of the editor, select .

6. (Optional) You can use the toggle button in the local toolbar to show properties below in a
group view or an alphabetical view .

7. Locate the property you want to change.

8. The area to the right of the property is used for selecting and entering values. If you know
how to enter the information correctly, you can click in the value field and type it
directly. Otherwise, click the ellipsis button to the right of the property. Depending on the
type of property, the appropriate controls and options display, allowing you to choose or enter
values (e.g., select from a drop-down list, click a button, complete fields in a dialog or
popup). If you completed values in a popup, click OK at the bottom of the box.

9. Click to save your work.
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CHAPTER 4

Micro Content Examples
There are seemingly countless use cases that might involve micro content, especially when
coupled with meta tags. In this section, we will cover some examples that illustrate what you can
accomplish with micro content. These examples deal only with adding micro content to search
results or topic output, not field-level Help or other uses such as chatbots.

The micro content in these examples will be displayed via the available containers, depending on
the circumstance:

n Featured snippets

n Knowledge Panel

n FAQ proxy

n Knowledge proxy

n Promotion proxy

The choices made in each example rely on the main characteristics desired for each case:

n Dynamic (i.e., uses search engine in output) or static (i.e., compiled at build time)

n Displays in search results or topic content

n Displays random results, best matches, or predetermined content

n Filter 1: Pulls from all micro content files, only certain micro content files, or only micro
content associated with certain meta tags

n Filter 2: Uses all micro content phrases, the topic title, the search query, or only certain micro
content phrases based on meta tag values
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NOTE There are multiple options available, especially in the micro content proxies. We are
not attempting to cover everything in these examples. For example, if you are curious about
the "Custom Text" filter option from the proxies, we are not including it in these examples,
but you can work through the Micro Content Tutorial—Advanced to see it in action.

NOTE The actual content isn't the most important aspect in these examples, because
micro content can contain whatever you want it to.

NOTE These examples sometimes include the use of meta tags. So it's a good idea to
learn the basics of meta tags and how they work.

This chapter discusses the following:

Examples—"What" and "How" Content 138

Examples—Related Information 154

Examples—FAQs 169

Examples—Random Tips 178
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Examples—"What" and "How" Content
If you simply want the most relevant pieces of micro content from topics in your project to display
in search results, the easiest solution is to use featured snippets and/or the Knowledge Panel. In
many cases, you will probably use these containers to display information that describes "what"
something is or "how" to perform a task. You could also use a Knowledge or Promotion proxy to do
this, but you probably would only do that if you wanted to place the containers in a location on the
search page that isn't possible with featured snippets or the Knowledge Panel. The bottom line is
that featured snippets and the Knowledge Panel are just easier for this kind of thing.

Display Micro Content in the Featured Snippets
Area

EXAMPLE

DESIRED CHARACTERISTICS
n Dynamic (i.e., uses search engine in output)

n Displays in search results

n Displays the best match

n Filter: Pulls from all micro content files and uses the search query

NOTE Not all of the characteristics above are mandatory to accomplish the results
you might want. They are simply the characteristics we selected for this example.
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STEPS

1. Open the HTML5 target, select the Search tab, and make sure you are using either
MadCap Search or Elasticsearch.
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2. Let's say you want only the best match to display. In the Featured Snippets section,
make sure the Filter is set to All micro content files, and Limit number of results is set
to 1.
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3. In the Knowledge Panel section, make sure the Filter is set to Do not include in search
results.

4. Click to save your work.
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WHAT HAPPENED

Flare found a micro content phrase in one of the files using the text "bulldog," and that was
the best match it found, so that's what displayed in the search results.

MICRO CONTENT FILE
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OUTPUT
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Display Micro Content in the Knowledge Panel

EXAMPLE

DESIRED CHARACTERISTICS
n Dynamic (i.e., uses search engine in output)

n Displays in search results

n Displays the best match

n Filter: Pulls from only certain micro content files and uses the search query

NOTE Not all of the characteristics above are mandatory to accomplish the results
you might want. They are simply the characteristics we selected for this example.
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STEPS

1. Open the HTML5 target, select the Search tab, and make sure you are using either
MadCap Search or Elasticsearch.

2. In the Featured Snippets section, make sure the Filter is set to Do not include in
search results.

CHAPTER 4  145



3. In the Knowledge Panel section, click the Filter field and select Specific micro content
files. In the field under that, select a micro content file (in this example, our file is
named About-Breeds.flmco). We could select more micro content files, but we'll just
use one. In the field below, make sure Limit number of results is set to 1.

4. Click to save your work.
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WHAT HAPPENED

Flare looked only in the specified micro content file and again found the micro content
phrase using the text "bulldog." The only difference is that this time Flare displayed it in the
Knowledge Panel area of the search results.

OUTPUT
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Display Micro Content in Both the Featured
Snippets Area and the Knowledge Panel

EXAMPLE

DESIRED CHARACTERISTICS
n Dynamic (i.e., uses search engine in output)

n Displays in search results

n Displays the best match(es)

n Filter: Pulls from only certain micro content files and uses the search query

NOTE Not all of the characteristics above are mandatory to accomplish the results
you might want. They are simply the characteristics we selected for this example.
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STEPS

1. Open the HTML5 target, select the Search tab, and make sure you are using either
MadCap Search or Elasticsearch.

2. In the Featured Snippets section, click the Filter field and select Specific micro
content files. In the field under that, select a micro content file (in this example, our
file is named About-Breeds.flmco).

Let's say we want Flare to display the best two matches it finds (if there are two
matches). Set the Limit number of results field to 2.
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3. In the Knowledge Panel section, click the Filter field and select Specific micro content
files. In the field under that select two micro content files (in this example, our first
file is named FAQs.flmco and our second file is named Training-Steps.flmco). In the
field below, make sure Limit number of results is set to 1.

4. Click to save your work.
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WHAT HAPPENED

The user searched for "Retriever," and Flare found multiple micro content phrases using
that text. So it displayed the responses for those micro content phrases accordingly in the
search results. It's possible that micro content could have displayed in only one of the
containers, or none at all, depending on whether matches were found in the micro content
files. But in our case, there were matches found in multiple micro content files to populate
both containers.

ABOUT-BREEDS MICRO CONTENT FILE
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TRAINING-STEPS MICRO CONTENT FILE
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OUTPUT

IMPORTANT Remember, it doesn't matter that any of the actual content in the
responses contained the word "retriever." The important detail is that the micro
content phrases contained "retriever," thus matching the keyword of the user's
search.

CHAPTER 4  153



Examples—Related Information
There are times when you might want to display related information next to regular topic content or
in search results. This might be something like PDF or video links, technical specifications,
warnings, tips, and so on. A good way to accomplish this is to use micro content proxies and meta
tags.

Display Dynamic PDF Links in Topics—Best
Matches

EXAMPLE

DESIRED CHARACTERISTICS
n Dynamic (i.e., uses search engine in output)

n Displays in topic content

n Displays the best matches

n Filter 1: Pulls from only certain micro content files

n Filter 2: Uses only certain micro content phrases based on meta tag values

NOTE Not all of the characteristics above are mandatory to accomplish the results
you might want. They are simply the characteristics we selected for this example.
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STEPS

1. Create a meta tag set with a list of meta tag values representing the PDF links. In our
example, we have a meta tag set called "Resources," with a meta tag named "PDFs,"
and values that look like this.
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2. Create micro content files containing phrases that match the names of the meta tag
values. In our example, we have our PDF phrases in two different micro content files,
although we easily could have put them all in one.

3. In the template page you are using for your topics, add a responsive layout, placing
the Topic Body proxy in the left cell. Then, place your cursor in the right cell, and
select Insert > Proxy > Knowledge Proxy.

NOTE A responsive layout isn't mandatory, but it helps us get the structure
we want in the output, with the topic content on the left and the micro
content on the right.

4. In the Knowledge Proxy dialog, click in the Proxy Title field and enter Additional
Resources. This is optional, but we'll do it in this example so we can give our users
an indication that we're listing some PDF links that they might want to open. In the
first filter, select Specific micro content files and select the two micro content files
containing our PDF links. Then, in the second filter field, select Meta tag value and
choose PDFs (the name of our meta tag). Finally, set Limit number of results to 3.
Even though we have more PDFs than that, we want only the top three matches to
display. Click OK when finished.
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In our example, the responsive layout in the template page is designed to use two-
thirds of the space on the left for the regular topic content, and one-third of the space
on the right for the micro content (i.e., PDF links).

5. Click to save your work.

6. Right-click a topic where you want related PDF links to display, and select Properties.
On the Meta Tags tab, select the meta tag values associated with the PDF links that
you want to display. Here is how we did it for two of our topics.
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If we wanted to display more or fewer PDF links in a topic, we could easily edit the
Knowledge proxy and change the Limit number of results field.

OUTPUT

NOTE In this example, all of our meta tag values matched perfectly with the micro
content phrases. So it's not easy to determine why the search engine algorithm
chose the top three matches for each topic. If you want to make sure certain
pieces of micro content are always shown for a particular topic, you might consider
using the FAQ proxy, which is used in another example in this topic.
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Display Dynamic PDF Links in Topics—Random
Results

EXAMPLE

DESIRED CHARACTERISTICS
n Dynamic (i.e., uses search engine in output)

n Displays in topic content

n Displays results randomly

n Filter 1: Pulls from only certain micro content files

n Filter 2: Uses only certain micro content phrases based on meta tag values

NOTE Not all of the characteristics above are mandatory to accomplish the results
you might want. They are simply the characteristics we selected for this example.
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STEPS

This example is nearly identical to the previous one. The main difference is that we are
using a Promotion proxy instead of a Knowledge proxy. So use the same steps, but select
Insert > Promotion Proxy when editing the template page. The settings in the dialog would
look like this, the same as the settings in the Knowledge proxy dialog.

When viewing the topics in the output, different PDF links might display each time the topic
is opened or the page is refreshed.
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OUTPUT
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Display Static PDF Links Alphabetically in
Topics—Predetermined Content

EXAMPLE

DESIRED CHARACTERISTICS
n Static (i.e., compiled at build time)

n Displays in topic content

n Displays predetermined content

n Displays micro content in alphabetical order

n Filter 1: Pulls from only certain micro content files

n Filter 2: Uses only certain micro content phrases based on meta tag values

NOTE Not all of the characteristics above are mandatory to accomplish the results
you might want. They are simply the characteristics we selected for this example.
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STEPS

This example starts out the same as the Knowledge proxy scenario above. Create a meta
tag set and micro content files, with values the same as described above .

Once you have the template page open with the responsive layout created, continue with
the following steps.

1. Place your cursor in the right cell of the responsive layout, and select Insert > Proxy >
FAQ Proxy.

2. In the FAQ Proxy dialog, click in the Proxy Title field and enter Additional
Resources. In the first filter, select Specific micro content files and select the two
micro content files containing our PDF links. Then, in the second filter field, select
Filtering by topic meta tag value. In the first drop-down field, select PDFs (the name
of our meta tag). You can leave the second drop-down field as it is. Finally, select
Sort phrases in alphabetical order. Click OK when finished.
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3. Click to save your work.

CHAPTER 4  165



4. Just as with the other examples above, you need to associate the desired meta tag
values with topics. In this example, we'll assume you've done this as described in the
first example above.

5. We also need to associate the micro content phrases (i.e., their properties) with the
appropriate meta tag values. So open each micro content file being used, right-click
each phrase, select Properties, and on the Meta Tags tab, select the corresponding
meta tag value. In our example, one of the micro content phrase properties would be
set up like this.

6. Click to save your work.
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7. Each type of proxy displays in its own default view mode. For the FAQ proxy, it uses
drop-downs. But in this situation, we probably would like to use a different view. So
open the skin being used for the output (unique skin components can also be
associated with proxies). On the Setup tab, in the Proxy Options section, click the
FAQ Proxy View Mode field and select Plain Text.

8. Click to save your work.
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OUTPUT

PROXY DIFFERENCES

In the examples covered in this topic, the big differences between the FAQ proxy and the
others are: (1) With the FAQ proxy, you're going to get exactly the PDF links you tell Flare to
show (without limiting the number), and (2) the PDF links can be sorted alphabetically
(according to the micro content phrases).

NOTE There is a lot more you can do to modify the micro content in these
examples. For example, you might have noticed that each micro content result
displays with its own border. This is something that could be changed in the skin.
You could remove the borders altogether, or you could change the fields so that
only one border displays around all of the micro content.
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Examples—FAQs
Generating a set of frequently asked questions (FAQs) from micro content is something you might
want to do in your project. Flare's FAQ proxy is an obvious choice for this. However, that proxy is
really designed to be integrated into topic output only, not search results. So in order to add FAQs to
search results, you can use a Knowledge proxy instead.

Display Static FAQs in Topics

EXAMPLE

DESIRED CHARACTERISTICS
n Static (i.e., compiled at build time)

n Displays in topic content

n Displays predetermined content

n Structured for rich results on Google

n Filter 1: Pulls from only certain micro content files

n Filter 2: Uses all micro content phrases

NOTE Not all of the characteristics above are mandatory to accomplish the results
you might want. They are simply the characteristics we selected for this example.
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STEPS

1. Create a micro content file containing questions for your phrases and corresponding
responses. In our example, we have done this in a file called "FAQs.flmco."

NOTE Although a phrase can also have alternate phrases, only the main
phrase will be used in the output generated from an FAQ proxy. If you have
an alternate phrase that you want to be used instead, you can right-click it
and select Set as Main Phrase.

2. Open a topic (or template page) and place your cursor where you want the generated
FAQs to display. Select Insert > Proxy > FAQ Proxy.

3. In the FAQ Proxy dialog, click in the Proxy Title field and enter Frequently Asked
Questions. This is optional, but we'll do it in this example. In the first filter, select
Specific micro content files and select the micro content file containing the FAQ
phrases (in our case, FAQs.flmco). Leave the second filter field set to All micro
content. Finally, select Generate FAQ structured data. This will structure the topic
metadata so that it is possible (though not guaranteed) that Google might add the
FAQs as a rich result when people perform a search that matches the content. Click
OK when finished.
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4. Click to save your work.
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OUTPUT

NOTE By default, the content generated from an FAQ proxy will display in drop-
downs. This can be changed in the skin (or in a unique skin component that can be
associated with the proxy).
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Display Dynamic FAQs in Search Results

EXAMPLE

DESIRED CHARACTERISTICS
n Dynamic (i.e., uses search engine in output)

n Displays in search results

n Displays best matches

n Filter 1: Pulls from only micro content associated with certain meta tags

n Filter 2: Uses the search query

NOTE Not all of the characteristics above are mandatory to accomplish the results
you might want. They are simply the characteristics we selected for this example.
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STEPS

This example begins the same as the previous one, by creating a micro content file
containing FAQ phrases and responses. Once this is done, continue with the following
steps.

1. Create a new custom topic to hold search results (rather than using the built-in page
from Flare). In this example, we named our topic "Search-Results.htm."

2. In that topic, remove the placeholder text and add a responsive layout.

NOTE A responsive layout isn't mandatory, but it helps us get the structure
we want in the output, with the regular search results on the left and the
micro content on the right.

3. In the left cell of the responsive layout, insert a Search Results proxy (Insert > Proxy >
Search Results). Then, place your cursor in the right cell, and select Insert > Proxy >
Knowledge Proxy.

4. In the Knowledge Proxy dialog, click in the Proxy Title field and enter Frequently
Asked Questions. This is optional, but we'll do it in this example. In the first filter,
select Specific micro content files and select the micro content file containing the
FAQ phrases (in our case, FAQs.flmco). Then, in the second filter field, select Search
query. Finally, set Limit number of results to 4. Even though we have more FAQs than
that, we want only the top four matches to display. Click OK when finished.
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In our example, the responsive layout in the topic is designed to use two-thirds of the
space on the left for the regular search results, and one-third of the space on the right
for the micro content (i.e., FAQs).

NOTE If you have a template page that also contains a responsive layout,
you might want to create a unique template page just for the custom search
results topic. That template page should have just the Topic Body proxy in it.
That way, you won't experience extra empty space on the side when users
see the search results page in the output.

5. Click to save your work.

WHAT HAPPENED

The user searched the term "dog." Flare found three micro content phrases using that word,
so it displayed only those responses in the search results.
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MICRO CONTENT FILE

OUTPUT
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Examples—Random Tips
With a Promotion proxy, the results are random. This can make the Promotion proxy a good choice
for tips and tricks, which is what we illustrate in these examples. First, we will show how you can
accomplish this in search results. After that, we will demonstrate how to show random tips in
related topics.

Display Dynamic, Random Tips in Search
Results—Based on Search Query

EXAMPLE

DESIRED CHARACTERISTICS
n Dynamic (i.e., uses search engine in output)

n Displays in search results

n Displays random content

n Filter 1: Pulls from only certain micro content files

n Filter 2: Uses the search query

By basing the results on the user's search query, Flare won't display just any tips in our
micro content file. Instead, it will show only tips whose micro content phrases match
(at least partially) the search keywords.

NOTE Not all of the characteristics above are mandatory to accomplish the results
you might want. They are simply the characteristics we selected for this example.
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STEPS

1. Create a micro content file containing tips. In our example, we have created some
dog training tips and saved them in a file called "Tips.flmco."

2. Create a new custom topic to hold search results (rather than using the built-in page
from Flare). In this example, we named our topic "Search-Results.htm."

3. In that topic, remove the placeholder text and add a responsive layout.

NOTE A responsive layout isn't mandatory, but it helps us get the structure
we want in the output, with the regular search results on the left and the
micro content on the right.

4. In the left cell of the responsive layout, insert a Search Results proxy (Insert > Proxy >
Search Results). Then, place your cursor in the right cell, and select Insert > Proxy >
Promotion Proxy.
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5. In the Promotion Proxy dialog, in the first filter, select Specific micro content files and
select the micro content file containing the tips (in our case, Tips.flmco). Then, in the
second filter field, select Search query. Finally, make sure the Limit number of results
is set to 1. We could display more tips if we wanted, but our goal is to show just one
random tip whenever a user performs a search that matches (at least partially) the
phrases in the micro content file. Click OK when finished.
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In our example, the responsive layout in the topic is designed to use two-thirds of the
space on the left for the regular search results, and one-third of the space on the right
for the micro content (i.e., tips).

NOTE If you have a template page that also contains a responsive layout,
you might want to create a unique template page just for the custom search
results topic. That template page should have just the Topic Body proxy in it.
That way, you won't experience extra empty space on the side when users
see the search results page in the output.

6. Click to save your work.

WHAT HAPPENED

The user searched the term "dog." Flare found two micro content phrases using that word,
so it displayed only those responses in the search results. However, the results are random.
So if you keep performing a search for "dog" (or refresh the page), it might show one of
those two pieces of micro content.
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MICRO CONTENT FILE

OUTPUT
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Display Dynamic, Random Tips in Search
Results—Using All Micro Content Phrases

EXAMPLE

DESIRED CHARACTERISTICS
n Dynamic (i.e., uses search engine in output)

n Displays in search results

n Displays random content

n Filter 1: Pulls from only certain micro content files

n Filter 2: Uses all micro content

By basing the results on all micro content, Flare will randomly display any tips in our
micro content file, whether those phrases match the search query or not.

NOTE Not all of the characteristics above are mandatory to accomplish the results
you might want. They are simply the characteristics we selected for this example.
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STEPS

This example is nearly identical to the previous one. We want to display any of the tips from
our micro content file (not just those matching the search query). So in the second filter of
the Promotion proxy dialog, we select All micro content.
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OUTPUT
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Display Dynamic, Random Tips in Topics—
Based on Topic Title

EXAMPLE

DESIRED CHARACTERISTICS
n Static (i.e., compiled at build time)

n Displays in topic content

n Displays random content

n Filter 1: Pulls from only certain micro content files

n Filter 2: Uses the topic title

By basing the results on the topic title, Flare looks to see which tips in our micro
content file match what it finds for the title in the <head> tag of the markup.

NOTE Not all of the characteristics above are mandatory to accomplish the results
you might want. They are simply the characteristics we selected for this example.
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STEPS

1. Create a micro content file containing tips. In our example, we have created some
dog training tips and saved them in a file called "Tips.flmco." Notice that we added
the text "roll over" to each one of the phrases, just for demonstration purposes in this
example. This text matches the main heading for one of our topics ("Roll-Over.htm).
And since Flare automatically uses the main heading text as the topic title (unless
you specify otherwise in the topic properties), we have matched the topic with all four
of our tips.

2. In the template page you are using for your topics, add a responsive layout, placing
the Topic Body proxy in the right cell. Then, in the left cell, place your cursor and
select Insert > Proxy > Promotion Proxy.

NOTE A responsive layout isn't mandatory, but it helps us get the structure
we want in the output, with the topic content on the right and the micro
content on the left.
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3. In the Promotion Proxy dialog, in the first filter, select Specific micro content files and
select the micro content file containing the tips (in our case, Tips.flmco). Then, in the
second filter field, select Topic title. Finally, make sure the Limit number of results is
set to 1. We could display more tips if we wanted, but our goal is to show just one
random tip whenever a user opens a topic where the title matches (at least partially)
the phrases in the micro content file. Click OK when finished.
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In our example, the responsive layout in the template is designed to use one-third of
the space on the left for the micro content (i.e., tips) and two-thirds of the space on
the right for the regular topic content.

NOTE If you open a topic in the output where the title matches the micro
content phrase(s) (in our case, the "Roll-Over.htm" topic), a tip will display to
the left of the content. If you open a topic in the output where a match does
not exist, the topic will shift to the left, with no tip shown.

4. Click to save your work.

OUTPUT
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CHAPTER 5

Other Information for Micro
Content
In addition to the primary concepts, there is some additional information that might help you when
working with this feature.

This chapter discusses the following:

Micro Content and Glossary Terms 195

Micro Content Reports 196
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Micro Content and Glossary Terms
Supported In:

If you have a glossary term that is the same as a micro content phrase, both will be displayed in the
output. The micro content featured snippet will be on top, with the glossary term following it.
Depending on how similar the content is between them, you might decide to remove one of them so
that you are not displaying duplicate information to end users.
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Micro Content Reports
You can run reports to find the following types of information about micro content:

n Duplicate Micro Content Phrases

n Files with Micro Content Links

n Micro Content Empty Phrases

n Micro Content Empty Responses
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CHAPTER 6

Other Activities for Micro
Content
In addition to the main activities, there are some other tasks you might perform regarding this
feature.

This chapter discusses the following:

Editing Micro Content Phrase IDs 198

Editing Micro Content Phrase Titles 201

Including or Excluding Micro Content Phrases in Search 204

Single-Sourcing Micro Content Using Conditions 206

Single-Sourcing Micro Content Using Styles 217

Method 2: Advanced Selectors in Same Stylesheet 234

Single-Sourcing Micro Content Using Variables 239
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Editing Micro Content Phrase IDs
When you create a micro content phrase, Flare uses that phrase as an ID for it, adding hyphens
between words as necessary.

This ID is used when you create a CSH ID for the phrase in the Alias Editor. It displays in the File and
Path cells, after #.
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If you change the text in this field…

… the CSH ID path changes accordingly.
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How to Edit a Micro Content Phrase ID
1. From the Content Explorer, find and open the micro content file.

2. On the left side of the Micro Content Editor, right-click a phrase, and from the context menu
select Properties. (Alternatively, you can select the phrase and click in the local toolbar or
press F4.)

3. In the Properties dialog, click the Phrase Properties tab.

4. In the Phrase ID field, change the text.

NOTE The Phrase ID field cannot be empty, and the characters must be lowercase.
You cannot use spaces, underscores, or other invalid characters between words;
instead, use hyphens.

5. Click OK.

6. Click to save your work.
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Editing Micro Content Phrase Titles
Each micro content phrase has a title, and by default, it is identical to the main phrase text.

This title can be used if you create field-level context-sensitive Help (CSH) and want to control the
text that displays in the browser tab that opens as a result.
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EXAMPLE Maybe your phrase is "set file format" (lowercase). But you want the browser
tab to display "File Format" (uppercase). Therefore, you change the field as follows.

The window tab in the output therefore displays this.
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How to Edit a Micro Content Phrase Title
1. From the Content Explorer, find and open the micro content file.

2. On the left side of the Micro Content Editor, right-click a phrase, and from the context menu
select Properties. (Alternatively, you can select the phrase and click in the local toolbar or
press F4.)

3. In the Properties dialog, click the Phrase Properties tab.

4. In the Phrase Title field, change the text.

NOTE There is also a button to the right of the Phrase Title field that lets you insert
variables as part of the title.

5. Click OK.

6. Click to save your work.
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Including or Excluding Micro Content
Phrases in Search

Supported In:

By default, micro content phrases and responses will be included in the search results of your
HTML5 output. However, there might be times when you want to exclude a particular phrase and
response from the search results.

EXAMPLE You have a micro content phrase called "transfer protocol," and the response
for this phrase describes a specific field somewhere in your product software user
interface.

You associate this phrase to a new CSH ID in the Alias Editor, with the idea of producing
field-level Help. When a user clicks a Help button next to this field, the short micro content
response for this phrase appears.

However, when users search for "transfer protocol" in your online Help, this same response
displays in the search results. The problem is that your response was really intended for
field-level Help only, and requires different wording or more information for it to make
complete sense without the context of the interface.

Therefore, you deselect the option in the Properties dialog. As a result, the response will
still be shown in the field-level Help, but it will not be included in the search results.
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How to Include or Exclude Micro Content
Phrases in Search

1. From the Content Explorer, find and open the micro content file.

2. On the left side of the Micro Content Editor, right-click a phrase, and from the context menu
select Properties. (Alternatively, you can select the phrase and click in the local toolbar or
press F4.)

3. In the Properties dialog, click the Phrase Properties tab.

4. At the bottom of the tab, enable or disable Include micro content in search results.

5. Click OK.

6. Click to save your work.
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Single-Sourcing Micro Content Using
Conditions

The Micro Content Editor lets you work with conditions in a couple of ways for single-sourcing.

Conditions on Phrases
You can apply conditions to individual micro content phrases. This lets you separate the phrases to
be included in different outputs.

How to Apply Conditions to Phrases
1. From the Content Explorer, find and open the micro content file.

2. On the left side of the Micro Content Editor, right-click a phrase, and from the context menu
select Properties. (Alternatively, you can select the phrase and click in the local toolbar or
press F4.)

3. In the Properties dialog, select the Conditional Text tab. The first condition tag set is selected
and the associated condition tags are shown on the right.

4. If you want to see condition tags for a different condition tag set, select it.

5. For each condition tag that you want to apply to the file, click the check box next to the tag. A
check mark appears in the box.
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6. Click OK. The square next to the file name in the Micro Content Editor now takes on the color
of the condition tag. If you applied more than one condition tag to the file, each color is
shown. (If you do not see squares, click in the local toolbar.)

EXAMPLE You have two HTML5 targets in a project—one named "Target1" and the other
"Target2." In addition, you have a couple of conditions named after each of these targets.
The Target1 condition is associated with green, and the Target2 condition is associated
with orange. Each target is set to include its conditions but exclude those from the other
target.

In a micro content file called "Interface," you have five phrases. You want the phrase "file
format" to be included as micro content only in Target 1, and you want the phrase
"synchronize" to be included as micro content only in Target 2. Therefore, you apply
conditions like this.
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After building and viewing the Target1 output, you search for each of these. The "file
format" micro content displays.

But the "synchronize" micro content does not display.

Then you build and view the Target2 output. The "synchronize" micro content displays.
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But the "file format" micro content does not display.
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Micro Content Conditions
There might be times when you want to show or hide certain content depending on whether it is
viewed in a regular topic in the output or when it is viewed as micro content (e.g., in search results).
This is possible for linked responses by using micro content conditions. It is similar to the snippet
conditions feature, but is for micro content only.

How to Use Micro Content Conditions
1. Create all of the conditions that you plan to apply within micro content responses.

2. Create a micro content file and create phrases linked to responses. This can be done by
tagging content in topics as micro content, or by linking phrases from the Micro Content
Editor.

3. Apply the necessary conditions to the text or other content in the linked responses.

TIP It is a good idea to enable the Hide/Show Conditional Indicators button at the
bottom of the editor so that you can clearly see where the different tags have been
applied.

4. In the Micro Content Editor, right-click the phrase and select Properties.

5. In the Properties dialog, select the Micro Content Conditions tab.

NOTE You will not see this option if you haven't linked the phrase to a response.
Instead, you will see "Snippet Conditions," which can be applied to content entered
directly in the Micro Response Editor, just as it can be applied in a regular topic.

6. If you want to exclude a condition tag from the micro content, select its row to highlight it.
Then click the Exclude option to the right. If you want to include a condition in the micro
content, select its row to highlight it, then click the Include option to the right.

7. Click OK.

8. Click to save your work.
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EXAMPLE You have a micro content phrase called "lady bird lake," which links to part of a
topic in your project. This response includes a heading, a paragraph, and an image.

When you generate the HTML5 output and search for Lady Bird Lake, you will see all of this
content in the micro content search results. And when you open the topic, you see the
same.
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Suppose you want the image to display only in the topic, but not in the micro content
search results. Therefore, you begin by creating a condition. Let's say you name it
"TopicOnly."

In the topic where the content exists, you apply this condition to the image. A small blue
square in the upper-right corner indicates that the condition is applied.
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Next, you open the micro content file, right-click the phrase, and select Properties.
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In the dialog, you select the Micro Content Conditions tab. Then you select the
Default.TopicOnly condition row and set it to Exclude.

After you click OK and save the changes, you build the HTML5 output.
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When you open the topic in the output, you see all of the content, including the image.

CHAPTER 6  215



But when you search for Lady Bird Lake, you only see the heading and paragraph in the
micro content.

NOTE If you want to include content in the micro content search results, but exclude it
from the topic in the output, it is probably easier to achieve this using styles.
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Single-Sourcing Micro Content Using
Styles

By default, micro content responses in the output look the same as the regular topic content. That's
because micro content files rely on the same stylesheet(s) set at the project, target, or topic level.
However, there are a couple of methods to navigate around this behavior so that you can use
custom styles when content is viewed as micro content, as opposed to how it looks in the full topic.
You can have a separate stylesheet for micro content responses, or you can create advanced
selectors in a single stylesheet.

Choosing a Method
The following might help you decide which method to use.

Method 1: Separate Micro Content Stylesheet Method 2: Advanced Selectors

Works for all kinds of micro content (search
results, topic output, context-sensitive Help
calls, etc.)

Works only for micro content displayed in
search results or topic output

Requires multiple stylesheets Can be done in one stylesheet

Probably easier for some users Users must know enough about CSS to create
advanced selectors

NOTE If you use both methods in your project, the advanced selector method will override
the settings in the micro content stylesheet for featured snippets in search results.

CHAPTER 6  217



Method 1: Separate Micro Content Stylesheet
You can create a separate stylesheet to be used specifically for micro content differences, and then
associate that stylesheet with a micro content file.

How to Associate a Stylesheet With a Micro Content
File

1. Create a separate stylesheet intended to be used specifically for micro content.

2. If you have a stylesheet set at the project or target level, make sure the option Allow local
stylesheets is selected.

3. In the Content Explorer, navigate to the folder holding the micro content file.

4. Right-click the file, and from the context menu select Properties.

5. Select the Stylesheet Links tab.

6. Double-click the stylesheet(s) that you want to associate with the micro content file. The
stylesheet is added to the Current Links section on the right.
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NOTE If you associate multiple stylesheets with the content file, the last one you
selected is the most recent one (the one on the bottom of the list) and therefore has
precedence over the others. However, you can use the up and down arrows to
change the order of the stylesheets.

NOTE If the stylesheet does not yet exist, you can click Add to create a new
stylesheet.

7. (Optional) You can also select the option Disable project, target and topic stylesheets if you
do not want to use any other stylesheets along with the micro content stylesheet.

8. Click OK. The stylesheet is now associated with the file, and the look of responses in the
Micro Content Editor changes accordingly.

9. Click to save your work.

EXAMPLE You have a topic with a set of steps that looks like this, with the list being used
as micro content:
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When viewed as a full topic in HTML5 output, you want the topic to look almost exactly like
this. The only exception is that the second note under step 2 should not be displayed.

However, when a user searches for "Procedure 1," you want the steps in the micro content
to look a little different. First, you want there to be less space between the list items.
Second, you want the first comment to be hidden, while the second comment is shown.

In your main stylesheet, you set the following. The first two generic style classes provide a
way to indicate which content should be shown in which form of output. And the other
selectors provide the spacing between the items in lists.

.topic-only
{

}

.micro-content-only
{
    display: none;
}

li,
li p
{
    margin-bottom: 24px;
    margin-top: 24px;
}
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You then add a second stylesheet. Its only purpose is to specify areas where content
should look different when viewed as micro content.

In the second stylesheet, you set the following. Notice that the settings for the generic style
classes are the opposite (hiding "topic-only" content and displaying "micro-content-only"
content), and the margin settings for list items are much lower.

.topic-only
{
    display: none;
}

.micro-content-only
{
    display: block;
}

li,
li p
{
    margin-bottom: 3px;
    margin-top: 3px;
}
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In the topic, you apply the topic-only class to the first comment and the micro-content-only
class to the second comment.

But you're not done yet. You need to make sure the correct stylesheets are used for each
circumstance. First, because your main stylesheet is set at the project level, you open the
Project Properties dialog (Project > Project Properties). In this dialog, you make sure that
Allow local stylesheets is enabled.
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Next, you open the Properties dialog for your micro content file.
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On the Stylesheet Links tab of that dialog, you move your special micro content stylesheet
to the right side, which means that the responses in that micro content file will give priority
to the style settings in that stylesheet. You leave the check box at the bottom disabled,
because you still want to use other styles from your main stylesheet as well.

Then you build and publish the HTML5 output.

If users view the full topic in the output, it looks like this. Notice the wider spacing, and the
fact that only one comment is shown under step 2.
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But if they view the micro content in the search results, it looks like this. Notice the list
items are closer together, and only the second comment is shown under step 2.

It's the same content, originating from the same place, but it displays differently depending
on the situation.

CHAPTER 6  225



NOTE You can use the Style Inspector to see links to stylesheets.
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What Happens With My Other Stylesheet(s)?
Your micro content can (and in most cases probably should) still use styles from your main
stylesheet. However, by pointing a micro content file to a separate stylesheet, you can override
certain style settings. So you do not need a completely separate set of styles in the stylesheet that
you associate with a micro content file; instead, you can just provide settings for styles where there
should be uniqueness.

EXAMPLE All of your style settings are contained in a primary stylesheet set at the project
level. At some point, you add a micro content file to your project, and you want the micro
content responses to use almost all of the same style settings from that project stylesheet.
The only exceptions are the h2 headings and paragraphs, where you want the font size to
be slightly smaller.

Therefore, you create a separate stylesheet for your micro content, and in it you provide the
smaller text sizes for the "h2" and "p" styles. You don't need to provide any other settings.

In your output, the micro content will continue to use all of styles from the project-level
stylesheet, including various settings for the h2 headings and paragraphs. The only
difference is that the font sizes of those headings and paragraphs will be smaller, using the
settings from the micro content stylesheet and ignoring the settings from the project
stylesheet.

Precedence

If you have multiple stylesheets with conflicting settings, the micro content stylesheet has highest
precedence.

The order of precedence works as follows when the content is viewed in the interface (XML Editor,
Micro Content Editor), as well as when it is displayed in the output.
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FLARE INTERFACE

1. Local stylesheet associated with micro content file

2. Local stylesheet associated with topics

3. Primary stylesheet (styles from only one primary stylesheet can be used)

a. Primary Target

b. Project

4. Branding stylesheet

OUTPUT

1. Local stylesheet associated with micro content file

2. Local stylesheet associated with topics

3. Local stylesheet associated with template pages

4. Primary stylesheet (styles from only one primary stylesheet can be used)

a. Any Target

b. Project

5. Branding stylesheet

EXAMPLE You have three stylesheets in your project. Two of them are local stylesheets—
one at the micro content level and the other at the topic level (for some topics). The third
one is a primary stylesheet that is set at the project level. (This example does not include a
branding stylesheet.)

n In the micro content stylesheet, you specify that paragraph text should be red.

n In the topic stylesheet, you specify that the paragraph text should be blue.

n In the project stylesheet, you specify that the paragraph text should be black.

What is the result in the output?

n In the micro content search results, the paragraph text will be red, overriding the other
colors.
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n In a full topic that is associated with the topic stylesheet, the paragraph text will be
blue, because it is not being viewed as micro content and it has precedence over the
project stylesheet.

n In full topics that are not associated with the topic stylesheet, the text will be black,
because it is not being viewed as micro content.

Enabling and Disabling Stylesheets

If you are working with multiple stylesheets in a project, keep in mind that there are options to
enable or disable stylesheets at different levels.

n Allow local stylesheets This option is located in the Project Properties dialog and the Target
Editor (where you select a primary stylesheet).
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n Disable project and target stylesheets This option is located in the Topic Properties dialog 
(where you select a topic stylesheet).

n Disable project, target, and topic stylesheets This option is located in the Micro Content
Properties dialog (where you select a micro content stylesheet).

The following explains what happens when various options in the interface are enabled or disabled.

IMPORTANT Keep in mind that even when disabling some stylesheets, those styles might
continue to be used in micro content search results. That's because the search results
page still relies on those other stylesheets. However, when viewed independently of search
results, the micro content will display as indicated below.
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Project or Target
Properties Topic Properties Micro Content Properties

Stylesheet(s) Used for
Micro Content

Only uses primary
stylesheet

Only uses micro content
stylesheet

Uses topic and micro
content stylesheets

Only uses micro content
stylesheet

Uses all three
stylesheets

Only uses micro content
stylesheet

Uses topic and micro
content stylesheets
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Project or Target
Properties Topic Properties Micro Content Properties

Stylesheet(s) Used for
Micro Content

Only uses micro content
stylesheet
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Method 2: Advanced Selectors in
Same Stylesheet

If you do not want a separate stylesheet for micro content responses, you can use descendant
advanced (complex) selectors in a single stylesheet, with the following generic classes in front of
your regular selector:

.micro-content-container .micro-response

NOTE It might be possible to use only .micro-response when creating a complex selector,
but in many cases both classes are needed: .micro-content-container and .micro-response.

EXAMPLE You have the following set of steps in a topic, and you want to create new micro
content from them.
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You right-click the ol structure bar and select Create Micro Content.
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In the dialog, you enter a micro content phrase and click OK. The phrase is added to the
micro content file and linked to the set of steps, as indicated by the extra structure bar in
the XML Editor.

When the steps are shown in the topic in the output, you want them to look just as they do
in the XML Editor. However, when the steps are shown in micro content search results, you
want the comment after Step 2 to be hidden. Also, you want to use a smaller font and less
space between the steps.
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So in your stylesheet, you create the following complex selectors:

In the XML Editor, you click on the paragraph after Step 2 and apply the .topic-only class to
it.
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When you generate and view the output, the topic looks like this:

And the micro content search result looks like this:
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Single-Sourcing Micro Content Using
Variables

There might be times when you want to change the definition to display for a variable, depending on
whether it is viewed in a regular topic in the output or when it is viewed as micro content (e.g., in
search results). This is possible for linked responses by using micro content variables. It is similar
to the snippet variables feature, but is for micro content only.
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How to Use Micro Content Variables
1. Create variables that you plan to use within micro content responses, and add multiple

definitions for those variables as necessary.

2. Create a micro content file and create phrases linked to responses. This can be done by
tagging content in topics as micro content, or by linking phrases from the Micro Content
Editor.

3. Insert variables as necessary in the responses.

4. In the Micro Content Editor, right-click the phrase and select Properties.

5. In the Properties dialog, select the Micro Content Variables tab.

NOTE You will not see this option if you haven't linked the phrase to a response.
Instead, you will see "Snippet Variables," which can be applied to content entered
directly in the Micro Response Editor, just as it can be applied in a regular topic.

6. Click the small down arrow on the right side of the variable row, and select the alternate
definition you want to use for the micro content.

7. Click OK.

8. Click to save your work.
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EXAMPLE You have a micro content phrase called "austin history," which links to part of a
topic in your project. Within the response content, you have inserted a variable that has a
definition of "University of Texas at Austin."

For the micro content search results, you decide you want to use a shortened version of
that—"University of Texas," leaving "at Austin" out of it. Therefore, in the Variable Set Editor,
you add another definition for that variable.

CHAPTER 6  241



Next, you open the micro content file, right-click the phrase, and select Properties.

In the dialog, you select the Micro Content Variables tab. Then, next to the variable, you
click the small down arrow and choose the shorter definition.

After you click OK and save the changes, you build the HTML5 output.
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When you open the topic in the output, you see the long version of the variable definition.
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But when you search for Austin History, you see the shorter version of the definition.
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APPENDIX

PDFs
The following PDFs are available for download from the online Help.

Tutorials
Getting Started Tutorial

Autonumbers Tutorial

Back-to-Top Button Tutorial

Context-Sensitive Help Tutorial

Custom Toolbar Tutorial

eLearning Tutorial—Basic

eLearning Tutorial—Advanced

Image Tooltips Tutorial

Lists Tutorial

Meta Tags Tutorial

Micro Content Tutorial—Basic

Micro Content Tutorial—Advanced

Responsive Output Tutorial

Single-Sourcing Tutorial

Snippet Conditions Tutorial

Styles Tutorials

Tables Tutorial

Word Import Tutorial
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Cheat Sheets
Context-Sensitive Help Cheat Sheet

Folders and Files Cheat Sheet

Learning & Development Cheat Sheet

Lists Cheat Sheet

Micro Content Cheat Sheet

Print-Based Output Cheat Sheet

Search Cheat Sheet

Shortcuts Cheat Sheet

Structure Bars Cheat Sheet

Styles Cheat Sheet
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User Guides
Accessibility Guide

Analysis and Reports Guide

Architecture Guide

Autonumbers Guide

Branding Guide

Condition Tags Guide

Context-Sensitive Help Guide

Eclipse Help Guide

eLearning Guide

Getting Started Guide

Global Project Linking Guide

HTML5 Guide

Images Guide

Import Guide

Indexing Guide

Key Features Guide

Lists Guide

MadCap Central Integration
Guide

Meta Tags Guide

Micro Content Guide

Navigation Links Guide

Plug-In API Guide

Print-Based Output Guide

Project Creation Guide

QR Codes Guide

Reviews & Contributions With
Contributor Guide

Scripting Guide

Search Guide

SharePoint Guide

Skins Guide

Snippets Guide

Source Control Guide: Git

Source Control Guide:
Perforce Helix Core

Source Control Guide:
Subversion

Source Control Guide: Team
Foundation Server

Styles Guide

Tables Guide

Tables of Contents Guide

Targets Guide

Template Pages Guide

Templates Guide

Topics Guide

Touring the Workspace Guide

Transition From FrameMaker
Guide

Translation and Localization
Guide

Variables Guide

Videos Guide

What's New Guide
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